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Executive Summary 

Importance and vision 

Spatial identification and prioritisation of sites suitable for restoration activities is a critical pre-requisite for 
the planning of any restoration project. This technical manual highlights the need in standardised approaches 
for conducting site suitability assessments and presents The Nature Conservancy’s (TNC’s) method for 
Restoration Suitability Modelling to guide restoration practitioners in applying this decision support tool. 

Increasingly, anthropogenic impacts on terrestrial, marine, and estuarine ecosystems are becoming a 
ubiquitous global concern. Climate change and the increasing magnitude, duration, and frequency of severe 
weather events are leading to a growing need to stabilise and restore ecosystems to provide protection and 
build resilience. The United Nations (UN) Decade on Ecosystem Restoration (2021 – 2030) is intended to 
facilitate global cooperation for the restoration of degraded and destroyed ecosystems. TNC, a leading global 
conservation organisation, developed this manual with the intent to catalyse development of high quality, 
well-planned approaches to shellfish reef restoration projects. Indeed, whilst this technical manual for 
restoration suitability modelling is presented in the context of shellfish reef restoration, it is important to note 
that each section of the manual may be adapted to target other habitats and species across marine and 
terrestrial realms with relative ease. 

TNC has a long history of experience in working to restore and recover degraded shellfish reefs. These 
shellfish reefs, predominately comprised of oysters and mussels, historically were an extensive ecosystem in 
intertidal and subtidal estuarine systems. In more recent years, in response to destructive commercial fishing 
practices and changing estuarine environments, shellfish reefs have experienced global population decline to 
approximately85% of historic populations. With the loss of these reefs, communities lost a wealth of 
ecosystem services, including high biodiversity, enhanced water quality, protection from shoreline erosion, a 
distinct fishery (bivalves) and an important habitat for life history stages of other fisheries species (e.g. finfish 
and crustaceans), as well as significant cultural values.  

Estuaries are often the centre of cultural and social importance in coastal communities, and as a result, 
substantial shifts in land and water use and quality have occurred to these systems. Rapid urbanisation of 
estuarine catchments, increased marine traffic and recreational use have led to substantial biogeochemical 
and physical changes of estuarine ecosystems. Natural flow regimes and larval settlement are altered due to 
modifications in hydrodynamic flow from dredge and fill activities, shoreline hardening, and increased 
boating/shipping traffic. Coastal land-use changes within estuarine catchments have also altered water 
quality, affecting animal and plant population dynamics.  

Cumulatively, anthropogenic alterations in many estuarine landscapes have shifted historical mosaics of 
complex biogenic (i.e., estuarine) habitats to systems supporting a complex array of anthropogenic services, 
features and areas with varied use and ecosystem condition based on relative human use. For successful 
shellfish reef restoration to occur in these modern estuarine systems, there are two factors needing 
consideration – first, whether the initial causes of shellfish reef decline have disappeared, and secondly, 
whether the shifting uses and dynamics of an estuary alter the suitability of the estuary (or a given site) on an 
ongoing basis. Restoration suitability modelling (RSM) is a term increasingly used in restoration ecology and 
planning to identify the fitness or suitability of a site for restoration purposes, building on concepts of Habitat 
Suitability (Index) Modelling. Here we describe an RSM method developed by TNC for shellfish reefs, which 
accounts for shifting landscape mosaic and includes relevant biological, ecological, logistical, and social 
parameters ultimately producing a relevant map to guide restoration site selection and prioritisation efforts 
based on the best available present-day data. 



 

 

 

The approach 

In developing an RSM, there are generally six steps practitioners need to take. Many of these steps are 
iterative and depend on strong communication with the local community, stakeholders, scientists, and 
traditional owners. 

1) Defining an ecological reference system 
An ecological reference system defines the designed model ecological ‘endpoints’ a restoration project is 
working towards. An ecological reference system describes the ecological community composition, structure 
and function of a restored system. 

The process of developing an ecological reference system, requires a firm understanding of the drivers of 
distribution for any given ecosystem, which in turn can be useful in the selection of model parameters and 
criteria, thus guiding further data acquisition efforts. 

At this stage, practitioners also need to consider on a regional level, where restoration projects may take 
place, and at what scale, based on the historic, current, and predicted future extent of target shellfish habitat. 
It is also important at the siting level to assess the local drivers to shellfish habitat disappearance and identify 
whether there are still local threats that would hinder restoration efforts. It is recommended input for local 
drivers be sourced from scientific literature, local historical documents, conversations with stakeholders and 
local communities. 

2) Establishing project goals, area of interest and model parameters 
Once the ecological reference has been defined, practitioners need to establish suitable project goals and the 
area of interest (AOI). The AOI is where the model will be conducted and project goals are defined after liaison 
with local stakeholders and project partners. Project goals and area of interest will inform the model 
parameters – including definition of an appropriate coordinate system and model resolution as well as data 
parameters to be included within the model. 

Data parameters included in restoration suitability modelling may include biological, physical, ecological, 
socio-economic and regulatory datasets. Parameters selected for each model may depend upon data 
availability, specific restoration objectives and project goals, as well as local and unique conditions. 

3) Organizing and preparing datasets 
Before constructing the model, it is important to organise (i.e., categorize) the data to be used. Consistency is 
crucial and all datasets should be converted to raster to construct the model described herein. Key steps in 
this stage are modifying and reclassifying or transforming data to ensure compatibility of parameters into the 
final model and GIS software of choice.  

4) Constructing the model  
Once all datasets are in the format of a reclassified raster layer (described herein), the model can begin to be 
constructed. The model is typically calculated using a Raster Calculator tool, whereby a geometric mean 
formula is used to specify how specific layers are multiplied together and weightings are subsequently 
applied.  

5) Evaluating model output  
After developing the restoration suitability model, several steps can be taken to ensure that final sites 
selected for restoration are selected with statistical confidence. To implement a model with confidence, there 
is a four-step approach applied, including development, calibration, verification and calibration. Furthermore, 
if available, model outputs can be compared to historic or current shellfish distribution maps. Ground-truthing 
potential restoration sites with site visits, is one of the most practical and recommended ways to assess the 
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accuracy of suitability model output – to either collect additional data to feedback into the modelling process 
or assist in prioritising potential sites. 

6) Communicating and applying model results 
Once the restoration suitability model is finalised, it is important to be able to communicate the modelling 
results in an effective manner to the surrounding community, project team, partners and stakeholders. It is 
advised to consult with relevant stakeholders (locals, community groups, scientists and Traditional Owners) 
prior to restoration sites being confirmed. Early engagement is often critical to building good community 
relationships, garnering support for restoration and ideally working towards a final agreement on sites that 
satisfies all parties. Based on community feedback received, a judgement call can be made on whether to re-
run the model with adjusted parameter criteria. This may involve preparing a short non-GIS technical report 
and producing static or interactive maps. It is always important to communicate this modelling process is not 
an authoritative stand-alone model and should be utilised to select suitable sites only when accompanied with 
site visits, stakeholder consultation and best judgment. 

Restoration suitability modelling is a continuously evolving and iterative process requiring semi-regular re-
evaluation and updates for each model. It is also essential that restoration suitability modelling practitioners 
regularly assess new and emerging technology, methods, tools, and data - each of which has the potential to 
improve workflows and confidence in model outputs. Increasing interest in restoration, and active shellfish 
reef restoration projects within Australia and globally, has led to the need to develop a standardised approach 
to restoration suitability modelling. This technical guide is designed for restoration practitioners, GIS 
technicians and spatial scientists aiming to design and construct restoration suitability models. Restoration 
suitability models are decision support tools acting as a guide for site selection; however, model validation is 
always important through ground-truthing model output. This document outlines global guidelines, logical 
steps, and discusses how site- and species-specific variations may be addressed in the site selection process. 

 

  



 

 

Introduction 

Ecological restoration is a global endeavour seeking to transition humanity away from being agents of 
degradation towards undertakings that conserve and recover natural systems.  Ecosystem restoration is a 
multidisciplinary, solutions-based approach engaging communities, scientists, policymakers, and land 
managers to repair ecological damage and rebuild a healthier relationship among people and the rest of 
nature. When ecological restoration is implemented effectively and sustainably, it can contribute to 
protecting biodiversity; improving human health and wellbeing; increasing food and water security; delivering 
goods, services, and economic prosperity; and supporting climate change mitigation, resilience, and 
adaptation. 

Shellfish reefs (encompassing oysters and mussels) were once ubiquitous in many shallow water marine 
environments, replacing corals as the dominant reef forming ecosystem in higher latitude systems. However, 
over the past two centuries, more than 85% of oyster reefs around the world have been lost (Beck et al., 
2011). In response, there has been a worldwide effort to restore shellfish reef ecosystems and the associated 
ecosystem services they provide, including water filtration, nutrient cycling, fish production, and shoreline 
protection (Fitzsimons et al., 2019; McLeod et al., 2019; Pogoda et al., 2019). The field of oyster restoration 
primarily developed in the United States over the past 20 years (Luckenbach et al., 1999; Schrack et al., 2012), 
but has recently expanded to new geographic regions such as Australia, New Zealand, Europe, and Asia 
(Fitzsimons et al., 2019, 2020), and has grown to encompass non-North American oyster species (e.g., 
Saccostrea glomerata, Ostrea edulis, Ostrea angasi, Magallana (Crassostrea) sikamea, Magallana 
(Crassostrea) hongkongensis), mussel species (e.g., Mytilus galloprovincialis and Perna canaliculus). 

In a shellfish restoration project, success is often defined as population persistence of the species targeted for 
recovery (Puckett et al., 2018; Lester et al., 2020). While there are many successes, poor siting decisions are 
widely considered to contribute to suboptimal results or failure of restoration projects (Coen and Luckenbach, 
2000; Powers et al., 2009; Beseres Pollack et al., 2012; Schulte and Burke, 2014; Bayraktarov et al., 2016; 
Walles et al., 2016; Bersoza Hernández et al., 2018; De Santiago et al., 2019).  

Whilst historic presence of shellfish 
reefs is frequently used as a good 
indicator of a site having the capacity to 
support a reef restoration project, many 
modern estuarine systems have 
dramatically changed, with limited 
function due to a wide variety of 
anthropogenic influences including 
destructive fishing practices, declines in 
water quality and disease introduction. 
Further anticipated changes (e.g. 
anthropogenic climate change and 
coastal development), may preclude 
the suitability of a historical site 
identification for contemporary 
restoration work (Howie and Bishop, 
2021). Therefore, due to the dynamic 
nature of these systems, site selection is 
a complex process requiring strategic 
decision-making using available data 

Figure 1. Example of the mapped output of a restoration suitability model 
developed for Saccostrea glomerata in Botany Bay, NSW, Australia. Suitable 
restoration areas range from very low suitability (light blue) to very high 
suitability (dark blue). Areas of unsuitable habitat are in light grey. 
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and/or models about appropriate locations, spatial extent and/or configurations of restoration projects. As 
such, restoration suitability models (e.g., mapped output of a RSM in Figure 1) built upon modern, robust 
geospatial data provide an essential framework for considering both present and predicted future conditions 
to maximize the likelihood of restoration success. 

Methodologies for restoration suitability modelling for shellfish reefs vary in complexity and design, and are 
often dependent on target restoration areas. Previously, approaches to ascertaining whether a site is suitable 
for shellfish reef restoration have ranged from simple summaries of information to more complex modelling 
approaches. Increased availability of large-scale environmental datasets, satellite imagery, and the emergence 
of contemporary Geospatial Information Systems (GIS) software, has led to a growing number of restoration 
practitioners applying the principles of restoration suitability modelling to the planning of both terrestrial and 
marine projects (Fitzsimons et al., 2020; Lester et al., 2020) (Figure 2). 

 

   
 Figure 2. Flow diagram illustrating stages of restoration suitability modelling, including relevant stakeholder engagement 
steps (orange) and data processing (green) steps. 



 

 

Restoration Suitability Models (RSMs) are an adaptation of traditional Habitat Suitability Index Models (i.e., 
Habitat Suitability Models) used extensively, and with success, to identify sites at which to establish/restore 
both terrestrial and marine habitats, including shellfish reefs (Theuerkauf et al., 2017; Theuerkauf, Eggleston 
and Puckett, 2019). Habitat Suitability Models (HSMs) 
utilize species-habitat relationships, with geospatial 
environmental data (usually biological and physical 
parameters) and corresponding tolerances of the target 
restoration species, to identify sites that are most likely 
to provide suitable habitat for the restoration species of 
interest. RSMs build on HSMs by including logistical, 
ecological and/or socio-economic parameters in addition 
to the physical and biological parameters (Figure 3). This 
more targeted modelling approach identifies sites not 
only based on habitat suitability but considers the actual 
feasibility of restoration and stakeholder preferences.  

Similar to marine spatial planning (MSP – see marine spatial planning & restoration suitability modelling box), 
it is important to note that HSMs or RSMs are intended to be based on the best available data; however, it is 
unlikely that there will be available authoritative data for every parameter of interest, or in the preferred 
spatial resolution. With this in mind, suitability models are often constructed using the best available 
contemporary data. In many cases, there may be limitations to an accurate representation of what is 
physically present in the estuary due to limited data quality or coverage. It is important to remember 
suitability modelling is not meant to precisely identify the perfect location for shellfish restoration, rather its 
purpose is to conduct compatibility screening to assist in guiding and prioritising candidate sites for further 
field validation and verification. 

Numerous HSMs or RSMs have been constructed to guide fishery production, aquaculture and restoration of 
shellfish species over the past 50 plus years (Theuerkauf and Lipcius, 2016; Jossart et al., 2020; Lester et al., 
2020). These efforts have largely been concentrated in North America (Soniat and Brody, 1988; Barnes et al., 
2007; Beseres Pollack et al., 2012), and to a lesser extent in Asia (Chowdhury et al., 2019) and Europe (Elsäßer 
et al., 2013) and have only recently been applied in the Oceania region (Howie et. al., In Prep). However, these 
models vary due to local and unique conditions of the study area, the available data and implementation 
approach. As a result of non-standardized approaches to developing suitability models, modelled outputs are 
generally not comparable among locations, possibly resulting in differing outcomes and success across 
restoration projects. 

 

Marine spatial planning & restoration suitability modelling 
The process for using RSMs to locate habitat restoration projects aligns closely with the marine spatial 
planning (MSP) process, and, indeed, can be incorporated into a broader MSP process if timelines and 
objectives align. MSP is a public, stakeholder-driven process of analysing and allocating the spatial and 
temporal distribution of human activities in marine areas to achieve ecological, economic, and social 
objectives that have been specified through a political process. MSP builds upon previous models of 
conservation planning by moving away from single-sector, single-objective considerations to meet a 
variety of socioeconomic and ecological objectives (UNESCO-IOC 2021). Similarly, RSMs go beyond the 
previous model where identifying habitat suitability is the only objective, to a process that can 
incorporate considerations on social parameters, including stakeholder preferences, conflicts and 
compatibilities with existing or planned human uses and/or habitats, and in some cases, economic 
outcomes. Akin to a MSP process, the process for RSM is driven by stakeholder engagement at 
multiple stages, best-available science and data on a wide variety of parameters, and, ideally, 
incorporates performance monitoring and evaluation metrics. 

Figure 3. Schematic diagram of data types that may be 
included in each restoration suitbaility model type. 

https://www.mspglobal2030.org/wp-content/uploads/2021/10/MSPglobal_InternationalGuideMSP_HighRes.pdf
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The push for a standardised approach has come from the recent investment in upscaling shellfish reef 
restoration in Australia. This scaling endeavour resulted in the need to for many restoration suitability models 
to run in parallel, emphasising the requirement for a standardised approach ensuring compatibility in the 
process among restoration locations. At a global scale, the UN Decade on Ecosystem Restoration will 
undoubtably lead to an increase in the delivery of restoration projects, therefore there is a need for 
documentation on good practices in spatial planning for restoration. This manual outlines the global 
guidelines, good practices, and logical steps to construct a restoration suitability model to assist in selecting a 
suitable site for shellfish reef restoration. This manual outlines the steps and processes in such a way that 
users of ArcMap and ArcGIS Pro will be able to follow. Whilst other GIS software packages are not the target 
software of this manual, the fundamental spatial analysis workflow involving similar steps and model-building 
approach should be applicable in all packages. 

This manual assumes basic familiarity with ArcMap/ArcGIS Pro vector and raster data formats, but is intended 
for users who have limited experience in raster modelling and analysis. 

 

Methodology 

1. DEFINING ECOLOGICAL REFERENCE ECOSYSTEM AND 
UNDERSTANDING DRIVERS TO DISAPPEARANCE 

Ecological restoration aims to create a self-sustaining ecosystem, 
that in time, closely resembles natural conditions and is resilient to 
perturbations (Gann et al., 2019). The success of restoration projects 
relies on two major elements: having clear and realistic goals and 
objectives for restoration  (Baggett et al., 2014; Ehrenfeld, 2000; 
Hobbs and Harris, 2001; Gann et al 2019; McDonald et al., 2016) and 
having reference models for a range of restoration approaches and 
techniques that could feasibly lead to the recovery of the target 
ecosystem. 

Where possible, restoration projects should employ the use of 
natural reference sites as a tool for measuring and assessing 
restoration success. Natural reference sites represent the 
fundamental conditions of the ecosystem undergoing ecological 
restoration, but have not been affected by degradation. It is likely 
that restoration sites will initially vary significantly compared to 
reference sites, however, assuming successful restoration and given 
time for recovery, the restoration and reference sites should 
become increasingly similar in terms of composition and function. In 
the absence of a natural reference site, a theoretical reference 
ecosystem can be developed as a guideline. A broad set of six ecological attributes underpinning theoretical 
reference systems, which are independent of species or ecosystem being restored, have been previously 
recommended (Table 1; Gann et al., 2019; McDonald et al., 2016). From this theoretical framework, the 
specifics of reference system can be developed through measurable indicators and interim conditions based 
on the knowledge of remaining natural populations, information on past conditions and modelling of future 
conditions (Society for Ecological Restoration, 2004). A reference ecosystem or model helps guide the project 

Figure 4: Native flat oyster (Ostrea angasi) 
reef. Credit: Chris Gillies 



 

 

design, selection of sites, set ecological targets and supports development of monitoring plans (Gann et al., 
2019). A reference ecosystem or model describes what is known about the ecosystem’s ecological and 
physical characteristics (see Gillies et al., (2017) for a shellfish example of a modelled ecosystem) and can be 
considered analogous to a builder obtaining the detailed engineering plans required to replicate an existing 
house (Fitzsimons et al., 2020). 
Table 1. Description of six key ecological attributes adapted from Gann et al. (2019); McDonald et al. (2016). 

Ecological Attribute  Description  

Absence of threats Direct threats are absent at the restored site (e.g., over-
utilization, contamination, invasive species) 

Physical conditions The restored site has the physical and chemical environmental 
conditions required to sustain the target species 

Species composition Appropriate native species are present at the restored site, 
while undesirable ones are absent 

Structural diversity The restored site has diversity within the demography of the 
desired species, wider trophic levels and associated vegetation  

Ecosystem function The restored site has appropriate levels of growth and 
productivity, nutrient cycling, decomposition, species 
interactions and disturbance rates 

External changes The restored site is appropriately integrated into the wider 
landscape and aquatic context through abiotic and biotic flows 
and exchanges 

 

 

The initial stages of developing a habitat or restoration suitability model, involves understanding the 
geographic focus and scope of proposed restoration activities. It is crucial to understand the factors that led to 
initial shellfish decline in the region, and assess any parameters currently limiting the natural recovery, as 
each of these may affect how the restoration project suitability model is approached. 

An assessment of the reversibility of parameters causing degradation is key to any restoration planning 
process. An ideal candidate for shellfish reef restoration would be an area where initial drivers for shellfish 
decline have subsided, and where substrate availability is limiting the natural recovery of the reefs, or where 
unsuitable environmental conditions exist (that may be remediated and their causes corrected or mitigated as 
part of the restoration activities). Estuaries which are still experiencing substantial anthropogenic or other 
stressors (i.e., limiting natural recovery), may require additional parameters to be considered in the modelling 
process or should be reconsidered altogether. Where broader intransigent environmental conditions exist that 
cannot be remediated, nor causes mitigated, the suitability of the site for restoring shellfish reefs may be 
reduced and the site rejected. Some examples of stressors that may still be present and limiting recovery may 
include wild fishing pressures (Breitburg et al., 2000) or predation (limiting natural recruitment to existing 
structures i.e. Esquivel‐Muelbert et al., (2022)). Parameters such as these may either be overcome by the 
consideration of these parameters in the restoration suitability model, or these limitations may be addressed 
post-modelling in the design and management of the reef restoration project. 
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2. PLANNING THE MODELLING APPROACH 

2.1 Developing project objectives and identifying specific area of interest to restore 
It is essential to define the objectives of the restoration project (e.g., population recovery, habitat 
enhancement), as the objectives will define what parameters are relevant to include within the RSM. Defining 
project objectives is an important stage where key stakeholders can be involved to shape a common or shared 
vision for the restoration project, and create buy-in for developing an RSM to serve as a data driven decision 
support tool. Engaging stakeholders in the early stages of 
objective setting can pave the way for setting specific 
parameters and siting criteria as described in the following 
sections. Typical project objectives will include maximizing 
the survival of the focal species while minimizing conflicts 
with existing uses or existing ecosystems in the areas of 
interest. However, some projects may also have an objective 
to optimise ecosystem services (e.g., water filtration, coastal 
protection, or fisheries enhancement), in which case 
additional data parameters (or differing combinations of 
parameters) will be necessary (See Table 5 (page 54) for some 
ideas). 

In establishing project objectives, it is advised that the SMART 
(Specific, Measurable, Attainable, Relevant and Timely) 
objectives framework is utilised (Skidmore et al., 2012). This 
should include establishing target project deliverables based 
on an understanding of what is technically feasible, 
economically viable and socially acceptable. The setting of 
SMART project objectives enables tracking and evaluation of 
overall project progress and effectiveness through application 
of objectives that test outcomes (Skidmore et al., 2012; 
Angelopoulos, Cowx and Buijse, 2017). 

 

2.2 Selecting relevant parameters 
For shellfish, the availability of suitable hard substrate for 
attachment, food availability, water quality parameters and 
the magnitude of top-down control by predators are all 
parameters that can influence reef development and 
persistence (Table 2). 

Parameters included in RSMs broadly include chemical and 
physical (e.g., water quality, current speed, bathymetry), 
ecological (e.g., habitat proximity and presence/absence 
data), socioeconomic (e.g., proximity to aquaculture sites, 
fishing areas, or marine infrastructure) considerations. RSMs 
also use existing regulatory boundaries (e.g., marine 
protected areas) to ensure restoration efforts do not overlap 
with sensitive habitats. Selections of parameters to include in 
each suitability model may depend on local unique 

Parameter Frequency 
of use 

Salinity 15 

Bottom type/substrate 9 

Water depth 9 

Water temperature 9 

Dissolved oxygen 8 

Turbidity 6 

Food availability/Chlorophyll a 5 

Disease 4 

Predator intensity 3 

Freshet frequency (rushes of 
freshwater) 

3 

Oyster abundance 2 

Fouling organisms 1 

pH 2 

Water flow 2 

Sedimentary environment 1 

References: (Cake, 1983; Brown and Hartwick, 
1988; Soniat and Brody, 1988; Battista, 1999; 
Barnes et al., 2007; Starke, Levinton and Doall, 
2011; Beseres Pollack et al., 2012; Cho et al., 
2012; Soniat et al., 2013; Swannack, Reif and 
Soniat, 2014; Linhoss, Camacho and Ashby, 
2016; Theuerkauf and Lipcius, 2016; McFarland 
and Hare, 2018; Puckett et al., 2018; Chowdhury 
et al., 2019; Aslam, Siddiqui and Kazmi, 2020). 

Table 2. Frequency of parameter use from 16 key 
publications on habitat suitability models for the 
restoration of oyster reefs. Adapted from Theuerkauf 
and Lipcius (2016). 



 

 

conditions, data availability and specific restoration goals and can be informed by expert and stakeholder 
opinion.  

The initial process of site and parameter assessment will assist in identifying data gaps around key parameters 
that should be included in the analysis. In the case of missing data, there may be scope to collect or create 
spatial data; for example field campaigns to collect water quality data or digitizing marine infrastructure from 
satellite imagery can act as supplemental data for areas lacking samples or to prioritize future sampling 
efforts. In some cases, ‘surrogate’ or proxy parameters may also be used as a substitute for unavailable data 
parameters, where parameters are closely correlated (e.g., depth can be used as a surrogate/proxy for 
dissolved oxygen if the correlative relationship is known). 

The concurrent step to parameter assessment is to consider how each data set will be factored into the 
analysis. Particularly, if the data vary across the project area as categorical or quantitative data, a decision as 
to how this information will be classified to inform restoration site selection must be made. Modelers will 
need to consider the format that this spatial data is in, as well as how this data may need to be edited or 
amended to be meaningful to analysis (please see more information in following sections).  

 

2.3 Assessing data availability and sources 
One of the most time-consuming aspects of habitat or restoration 
suitability modelling is acquiring and evaluating spatial data. Identifying 
potential datasets and sourcing from data providers can be a very lengthy 
process, and may still result in the procurement of an unsuitable spatial 
dataset in terms of resolution, format, or currency. For example, when the 
data set was collected in relation to when the RSM is being implemented – 
seagrass extent collected in 2010 but modelling undertaken in 2022. 
Ideally, spatial data included within an RSM will be of reasonably consistent 
spatial resolution and data quality.  

It is vital that each incoming dataset is assessed for quality assurance and 
quality control. 

Quality assurance refers to processes or methods to help prevent errors being introduced into the data (e.g., 
consider how data was collected, how error may have been introduced). 

Quality control refers to processes or tools used to identify any errors that are already in the dataset (e.g., the 
ArcGIS Check Geometry tool will generate a report of the geometry problems in a feature class). 

If sub-optimal quality data is included in the model, it is important to communicate this with the broader 
project team as a limitation or caveat of the final model output. The inclusion of an unsuitable or low-quality 
spatial dataset will affect the accuracy of the final suitability model, and ultimately may not provide an 
appropriate representation of the suitability of a site for restoration activities.  

If datasets are sub-optimal, but still important to include in the model or site selection process – there may be 
creative ways around this. For example, inadequate water quality data (e.g., single point measurements of 
dissolved oxygen) may be inappropriate for inclusion, as would incomplete data sets (e.g., features 
representing only a portion of the study area). In some cases, local system experts may be able to develop 
semi-quantitative or qualitative spatial datasets from limited input data (e.g., defining salinity zones within an 
estuary from limited point data vs. interpolation) allowing for limited use of data within the model. There is 
also the option of running two models – one with the sub-optimal data and without the data to determine the 
impact of the data on outcomes. 

If datasets are deemed to be unfit for inclusion, and/or no datasets are available for a specific parameter, it 
may be possible to verify that parameter during field validation exercises. Important considerations for 
determining the appropriateness of a data set to be included in the model consist of given parameter 
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importance, spatial data resolution, frequency of data collection, and data format. Knowing the right 
questions to ask potential data providers can save considerable time and effort during the acquisition phase 
of the process. 

Project teams are recommended to allow ample time in their work plans to reach out to data providers, 
acquire and evaluate spatial data. This step can often take more than two months, particularly where data 
sharing agreements may need to be drawn up. 
Table 3. Potential spatial data sources for Australian coasts and estuaries. 

Examples of data sources in Australia 

Data types: Bathymetry – varies by state, ELVIS a good place to start and it is 
recommended to get in contact with local councils. 
Water quality – Availability dependent on specific waterway, 
contact local councils. 
Habitat – Seamap Australia, 
Waterway uses – Roads and Maritime Services (NSW and other 
State equivalents) and/or local port authorities. 

Spatial data portals: AODN, ELVIS, National Maps, SEED Portal (New South Wales), 
NatureMaps (South Australia), DataShare (Victoria), LISTmap 
(Tasmania) etc. 

 

 

2.4 Developing parameter criteria and weights 
A range of relevant data parameters are brought together within a restoration suitability model to identify 
suitable locations for shellfish reef restoration. It is important to consider the suite of parameters to be 
integrated within an RSM as they relate to the needs of specific study systems (e.g., salinity, depth), as well as 
the individual parameter-level criteria used to define suitability (e.g., suitable vs unsuitable salinity ranges for 
restorations targets species). A sample table of data parameters, their associated considerations, parameter 
criteria and weights, can be found in Appendix A. 

Depending on the restoration goals of the project, incorporating restoration practitioners and relevant 
stakeholders into the RSM planning (parameter selection, criteria and weighting) can be a valuable 
opportunity to incorporate local knowledge into 
restoration modelling and to secure buy-in to the 
model and subsequent support for restoration 
planning. 

 

2.4.1 Parameter criteria 
Parameter criteria are applied to datasets at the 
individual parameter-level to define suitability scores 
related to each parameter. Within a suitability model, 
there are generally two key types of data, each of 
which are treated differently when applying suitability 
scores and weightings: gradient and binary data 
parameters. 

Binary data parameters are primarily used to indicate areas of exclusion from suitability for restoration 
(sometimes referred to as an ‘exclusion analysis’), and the suitability scores are applied on a scale of 0 - 1, 

Figure 5. Schematic diagram indicating important 
considerations that should be taken into account when 
selecting parameters and constructing parameter criteria. 

https://elevation.fsdf.org.au/
https://seamapaustralia.org/
https://portal.aodn.org.au/search
https://elevation.fsdf.org.au/
https://nationalmap.gov.au/
https://www.seed.nsw.gov.au/
http://spatialwebapps.environment.sa.gov.au/naturemaps/?locale=en-us&viewer=naturemaps
https://datashare.maps.vic.gov.au/
https://maps.thelist.tas.gov.au/listmap/app/list/map


 

 

where 0 indicates unsuitable conditions and 1 indicates no effect on suitability. For example, areas 
corresponding with vessel navigation (i.e., mooring areas or boating channels) are unsuitable for construction 
of a restored shellfish reef, however spaces outside this exclusion area are deemed suitable – based on this 
one criteria – as they are outside of the navigation exclusion zone– these areas would receive a suitability 
score of 1 as the model requires them to have no effect on the site suitability when combining parameters. 

Gradient data parameters (e.g., water quality or bathymetry) are delineated with the application of 
continuous or categorical suitability scores. These relationships are typically derived from available scientific 
evidence and literature (e.g., studies of growth or mortality of oysters related to salinity ranges). Here 
suitability scores are applied on a scale of 0 – 4, where 0 indicates unsuitable conditions and 4 indicates 
optimal conditions. Whilst the scale used is relatively arbitrary, we have found that a scale of 0 - 4 provides 
sufficient differentiation between suitability scores, while also being intuitive. Other studies have varied scales 
used for suitability scoring (i.e., 0 - 1 or 0 - 10), all of which are acceptable. Whilst it is largely inconsequential 
which scoring system is used, we recommend selecting a scoring system that creates contrast amongst 
parameters and increases the interpretability of model outputs. Gradient data parameters may also have 
parameter weightings applied to them and must be reclassified to the same suitability scale as the final 
model, prior to calculation. Binary data parameters typically will be on a scale of 0-1, where 0 indicates 
unsuitable areas and is excluded, and 1 indicates that the area is not suitable but beyond these exclusion 
zones, there is no physical or ecological benefit to shellfish being restored there. 

 

2.4.2 Parameter weights  
Weights can be assigned to individual parameters combined within an RSM, either as equally weighted 
parameters in the model (i.e., all parameters have equal importance) or relative weighting based on expert 
input regarding the importance of various parameters in defining suitable areas for restoration. For example, 
in a simple RSM that includes salinity, bottom type, and depth, equal weightings of 33.33% can be assigned to 
all parameters indicating equivalent importance of all three parameters in defining suitability within the RSM 
(i.e., 33.33% x 3 parameters = 100%). Conversely, if an individual parameter is known to be a major driver of 
restoration suitability, it can be assigned a higher weight relative to other parameters (e.g., 50% for salinity, 
25% for bottom type, and 25% for depth) resulting in a greater effect of salinity in driving the overall results of 
the RSM.  

Parameter weightings are best incorporated when there is a multitude of gradient parameters incorporated 
into the model, each of which are driving spatial patterns of suitability. Ideally, parameter weights should be 
accurate representations of the relative importance of model parameters. However, there is often little 
information describing how each parameter influences the restoration success of a focal restoration species. It 
is good practice to counteract this lack of information, by engaging a group of expert stakeholders to help 
determine weights of each gradient model parameter – or if this is not feasible equal weightings may be 
applied across all parameters. 

 

Determining weights 
Where expert stakeholders are required to assist in defining parameter weights, care must be taken to select 
suitable stakeholders with exceptional knowledge of the target species biology, restoration ecology, or the 
targeted region in which restoration will take place. Look towards researchers who have published work on 
the biology or ecology of your target species, local fishery or coastal habitat managers, restoration 
practitioners, and shellfish aquaculture practitioners operating in (or nearby) the target region. 

In determining parameter weights with a group of stakeholders, consider having either an in-person or online 
workshop, and using an online survey to collect and collate responses (e.g., Survey123, Google Forms or 
SurveyMonkey) 
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When constructing the survey, it is good practice to request respondents to assess the relative importance of 
parameters by scoring individual parameters on a linear scale. It is also important to provide ample 
introduction and detail on how to interpret the scale, and the purpose of this exercise. For example, the 
survey could ask respondents to identify whether each parameter is worthy of inclusion in the model, and 
then assess the relative importance of these parameters on a linear scale from 1 (least importance) to 10 
(high importance). 

Further discussions can be facilitated based on the results of this survey, particularly where there are wide 
discrepancies across respondents. Depending on the results from the survey and workshops, resulting 
weighting scores should be discussed by the project team before deciding to incorporate the final weights in 
the calculation of the RSM. 

Sensitivity analyses 
Sensitivity analyses provide an opportunity to assess the relative effect of individual parameters and the effect 
of parameter weightings on driving RSM results (see Puckett et al., 2018 for an example of this). 

Typically, sensitivity analyses assess the relative effect of individual parameters by using a ‘leave-one-out' 
approach, where a single individual parameter (typically the highest weighted parameter(s)) are removed 
from the RSM and the suitability scores are re-calculated. On a cell-by-cell basis, the resultant change in 
suitability scores is typically calculated and compared amongst parameters. Those parameters that result in 
the largest change in RSM scores are considered the most sensitive parameters and predominant model 
drivers.  These analyses can be valuable to determine which parameters have the greatest net effect on RSM 
results. Additionally, these analyses can highlight where strategic investments in improving data quality would 
yield improvements in the RSM. 

Sensitivity analyses to assess the relative effect of parameter weightings typically compare weighted vs. 
unweighted RSMs. For example, an RSM that includes 10 parameters may have weightings assigned to each 
individual parameter as the result of an expert stakeholder group activity. On a cell-by-cell basis, the weighted 
model can be compared quantitatively to the unweighted model (e.g., 10 parameters each with 10% 
weightings = 100% total) to determine the effect of weightings on RSM scores. Evaluation of weighted vs. 
unweighted models can also be conducted qualitatively by comparing map outputs from the two. 

 

2.4.3 Guidelines for selecting parameter criteria and weighting parameters 
When choosing data criteria and weighting parameters, there are several parameters to consider, including: 

Scientific evidence 
Criteria and weights for data parameters should be based on scientific evidence (i.e. in published literature) 
and/or expert opinion. Good options are either undertaking or utilising existing literature reviews to identify 
reference systems (i.e. Gillies et al., (2017) McAfee et al., (2020)). Engagement with experts from early on will 
help define essential and ‘nice to have’ data parameters. These should be applicable to the target species, 
geographical region, proposed restoration technique, and restoration objectives as much as possible.  



 

 

Geographical and restoration goals 
Data parameters selected for inclusion and the criteria developed should be 
relevant to the local area and restoration objective. Both should reflect local 
stakeholder priorities, project feasibility constraints, as well as local conditions 
and unique features that may impact the project.  

Stakeholder consultation 
Consultation with central stakeholders should occur early in the process, as this 
will impact types of data needing to be collected. For example, fishery 
stakeholders may wish to avoid having shellfish reefs constructed in key fishing 
areas, particularly if fishing gear could damage, or be damaged by the on-
ground works associated with restoration activities (e.g., constructed reefs). 
Alternatively, some fishery stakeholders might view nearby shellfish reefs as 
having a habitat enhancement value and may not identify any conflicts.   

It is important to map out the network of appropriate stakeholders to engage and assess when it is 
appropriate to engage different stakeholders at different stages throughout the modelling process. This can 
be valuable to assuage any community concerns (from restoration activities), to identify key conflicts in the 
area, as well as to secure buy-in and support for the project. Once the model has been constructed, taking 
their concerns into account, it is good practice to run model outputs by local stakeholders again. This ongoing 
relationship with local stakeholders throughout the course of the project builds trust with community groups 
and improves transparency and trust of modelling results. This can be critical when it comes to actual project 
implementation, transitioning from modelling to restoration activities. 

Whilst stakeholder consultations are a great way to address community concerns surrounding the project, 
conversations with community groups can also provide valuable insight into the system regarding local and 
unique conditions that are not necessarily captured by the data fed into the model. 

See Appendix B for suggested guidance for consulting with professional and community stakeholders over the 
RSM. 

Project feasibility 

Data parameters should reflect any project-level and/or logistical constraints around building the reefs. For 
example, some projects may opt to restrict building reefs to areas within a certain distance from shore, if 
there are complications with materials transport, or when it comes to monitoring reef development, this can 
become more hazardous to divers at depths below -15 m. 

Local conditions 

Some parameters may not be applicable to every project, in which case they may be excluded from the 
analysis. For example, some estuaries that are very well mixed and may not experience substantial spatial 
variation in dissolved oxygen throughout the area, in 
which case, it may not be necessary to include this as a 
parameter in the analysis. 

Unique local features 

The sample table example (Appendix A) does not contain 
a complete list of every parameter that may be important 
to a given geography. It may be necessary to include 
other information on maritime infrastructure or zones, 
major habitat/wildlife features, or other considerations 
that are unique to the area, especially if they will have a 
direct impact on the project’s objectives. For instance, in 

Figure 6. Spotted Handfish (Brachionichthys hirsutus). 
Credit: Handfish Conservation project. 
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south-east Tasmania, Australia, vulnerable populations of Handfish species (Figure 6) were identified and 
resulted in areas being excluded from RSM analyses. 

  



 

 

 

3. DATA ORGANISATION AND PREPARATION 

Before constructing the model, it is vital to make sure that all datasets are in a consistent format, coordinate 
system, extent and resolution. This section outlines steps to be taken to ensure that datasets can be overlaid. 
Having data organized in a structured way will also help keep track of files, of which there will be many. 

3.1 Data organisation 

 

3.2 Spatially defining an area of interest 
Defining the specific area in which the analysis will take place is important step to take early in the data 
preparation process, requiring input from end-users of the RSM in its definition. This will help to determine 
which features to include and will be useful later in the process when working with rasters. Prior to defining 
the area of interest in shapefile or polygon form, be sure to review Section 3.3 to select an appropriate 
coordinate system and projection. 

Shoreline datasets 
It is good practice to obtain a high-resolution shoreline dataset specific to the region in the data collection 
step, to create a spatial layer for the specific area of interest. However, where no shoreline data is available, 
this can either be extracted from bathymetric datasets (from the mean high water mark or similar), or 
extracted from global shoreline datasets (e.g. the Global Self-consistent, Hierarchical, High-resolution 
Geography Database) (GSHHG). 

https://www.soest.hawaii.edu/pwessel/gshhg/
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The area of interest for a given project may either be a specific embayment or estuary, or a stretch of 
coastline. For example, in Oyster Harbour, Western Australia (Australia), the entirety of the bay is considered 
the area of interest, but it is still necessary to define the boundary where the Bay meets the ocean, and how 
far into various inlets the model should extend (Figure 7). Comparatively, in South Australia near Adelaide, the 
area of interest was along a fairly linear stretch of coastline. In this case, to define the area of interest, a 
buffer was extended outwards from the shoreline to define extent (Figure 7).  

The main purpose of using a shoreline polygon or spatial base layer to define the area of interest is to be able 
to limit the extent of spatial analyses conducted when working with raster formats. If the shoreline file is in 
polygon or polyline format, these will eventually be converted into raster format. There are three ways to 
create a spatial base layer, as described below in ESRI workflows: 

From polygon 
When creating a spatial base layer 
from a polygon shoreline dataset, the 
first step is often to edit the vertices 
of the polygon to define the specific 
area of interest. First, use the 
Interactive Selection Tool, and drag 
the mouse to select the area of 
interest. Right click the shoreline 
layer in the Table of Contents (TOC) 
and choose Data>Export Data to save 
the selected features to a new 
dataset for editing. 

Turn on the editing tool (Customize-
>Toolbars->Editor) (Figure 8). Select 
layer in editor to edit. Generally, the 
two most useful tools in reshaping 
polygon features, is using the Edit 
Vertices or Split tools. Use the Edit Vertices tool to remove extraneous vertices and add additional 
vertices to close off the boundaries of the area to create an outline of the study area. For more 
information on using the Edit Vertices tools, see this link.  

Split tool is a quick way to split a single polygon feature into two, using the select tool you can then 
delete the unwanted polygon. This is often useful for cutting off inlets or rivers to exclude from an AOI. 

Figure 7. Defining area of interest for Oyster Harbour, WA (left) and along the 
Adelaide coastline, SA (right) in Australia. 

Figure 8. Editing Toolbar and Edit Vertices Tools in ArcMap (top) and ArcGIS 
Pro (bottom). 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-existing-features/editing-vertices-and-segments.htm


 

 

It is a best practice to save your edits often during an editing session in case of a software crash. Once 
the necessary features have been digitized, save the edits a final time and select Stop Editing from the 
Editing dropdown menu. For more information, see these links for creating and editing features, and 
the editing tutorial.  

From polyline 
If the geometry type was a polyline, rather than a polygon, the Polyline to Polygon tool (Data 
Management Tools > Features >Feature to Polygon) can be used. Once in polygon format, the above 
steps for polygon editing can be followed to define area of interest. 

From bathymetric data 
If you have bathymetric data (raster format) covering the AOI, a quick way to make a polygon feature 
of the area is to use the Reclassify tool to reclassify the raster (all grid values = 1), then convert the 
raster to a polygon. 

Eventually, you will want to use the Raster to Polygon tool, to create a base raster layer to use in 
subsequent raster analyses (Section 3.4.5). 

 

3.3 Choosing a coordinate system and projection 
Coordinate systems determine how the data are located on the earth’s surface, and a map’s projection 
determines how the data and coordinate system are represented on a two-dimensional surface. Flattening 
the earth’s three-dimensional surface distorts shape, scale, distance, direction, and area, and different map 
projections preserve these aspects to differing degrees (ESRI, 2022).  

It is important to understand that there are two main types of coordinate systems (Figure 9): Geographic 
Coordinate System and Projected Coordinate System.  

Geographic Coordinate Systems (GCS):  is a reference framework that defines the locations of features on a 
model of the entire globe. It is spherical shaped and units are angular, often degrees. 

Projected Coordinate System (PCS): contains a GCS, but converts the GCS into a flat surface, using a 
mathematical algorithm (differs between projections) and other parameters. Units are linear, often meters. 

GCS is needed for data to know where precisely on earth’s three-dimensional surface it is located. PCS is 
required to draw this data on a flat map. 

Learn more about coordinate systems and projections here. 

 

 

 

 

 

https://www.esri.com/arcgis-blog/products/product/data-management/getting-started-with-creating-features-in-arcgis-10/
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-fundamentals/about-edit-sessions.htm
https://desktop.arcgis.com/en/arcmap/10.3/manage-data/editing-fundamentals/introduction-to-the-editing-tutorial.htm
https://pro.arcgis.com/en/pro-app/help/mapping/properties/coordinate-systems-and-projections.htm
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Habitat suitability models often occur over relatively small areas, distortion 
is generally minimal, but it remains important to choose a projection that 
will be used consistently throughout the analysis. 

There are numerous resources online to help determine which coordinate 
system is appropriate for a given location, such as this article and this 
article, and the choice will often depend on project objectives.  

Particularly for restoration suitability models, it is important to use a PCS 
(not GCS), as PCS allow for geoprocessing operations (e.g., buffer tool), 
which are vital for development of RSMs. 

To view a summarized list of the coordinate systems used by all datasets, 
right click on the data frame, and choose the Coordinate System tabs 
(Figure 11). Once you have selected an appropriate coordinate system for 
the project, select it in the data frame properties and click “OK”. 

 

 

 

 

 

 

 

 

Figure 9. Comparison of Geographic and Projected Coordinate Systems. 

https://support.esri.com/en/technical-article/000006113
http://pbcgis.com/projection_fundamentals/
http://pbcgis.com/projection_fundamentals/


 

 

 

 

3.3.1 Projecting data 
For spatial datasets sourced for the project, it’ll be necessary to project these based on the selected 
coordinate system. 

For vector data (i.e. point data, polylines or polygons): Use the Project tool in the Data Management > 
Projections and Transformation toolbox. 

For raster data: Use the Project Raster tool in the Data Management > Projections and 
Transformations > Raster toolbox. 

To project large numbers of datasets with the same original coordinate system, choose the Batch 
function by right clicking on either of the tools (Figure 11). Alternatively, iterators can be used to semi-
automate this process (Check these resources for information on using iterators: this information page 
and instructional video). 

 

 

 

 

  

Figure 10. Example projected coordinate systems used in Australia. Map grid of Australia 2020 
(MGA2020), showing grid zones. The projection is divided into eight equal zones across Australia. For 
example, Sydney falls within MGA zone 56. 

https://desktop.arcgis.com/en/arcmap/10.3/analyze/modelbuilder/a-quick-tour-of-using-iterators-for-iteration-looping-.htm
https://www.youtube.com/watch?v=DoIkV2y0pEc
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Figure 11. Top (ArcMap): right click on Layers at the top of the Table of Contents and choose 
Properties. Bottom (ArcGIS Pro): Right click the Map you are working on in TOC and select Map 
Properties. 



 

 

3.4 Data manipulation – creating and converting spatial vector data 
Ideally, data providers will deliver datasets that are in formats that can be readily analysed in ArcMap or 
ArcGIS Pro and incorporated into the RSM. These formats include vector data (shapefiles or feature classes, 
sometimes stored in a geodatabase), and raster data. (Visit this link for a review of data formats). However, it 
may be necessary to convert or modify input data, or even create new data, to ensure compatibility. Some of 
the data conversion or creation tasks commonly used in suitability modelling are explained below in Figure 12. 

 

3.4.1. Importing data from tables 
If data are available in table form (e.g., .xlsx or .csv), they can easily be imported into ArcMap and converted 
to a shapefile if the latitude and longitude are present as fields. However, it may be necessary to prepare the 
input table so that it can be imported without error. First, ensure that your coordinates are in the format of 
decimal degrees. If they need to be converted from degrees, minutes, seconds, the following formula can be 
used:   

DD = d + (min/60) + (sec/3600) 

There are also some online conversion tools available to assist in coordinate conversions (e.g., this conversion 
tool), but if doing large batch conversions excel spreadsheets or R can also be useful and more efficient. 

Make sure that latitudes south of the equator and west of the Prime Meridien are specified as negative.  

Ensure that the column names are no longer than 13 characters, and that they do not contains spaces or 
special characters. It can often be helpful to convert a file to a .csv format as this tends to reduce import 
errors. It is best to add another column called ‘ObjectID’, which has a unique number for each row or data 
feature. 

Figure 12. Schematic diagram on how to format a diversity on incoming GIS datasets to make suitable for incorporation into a 
suitability model. 

https://www.gislounge.com/geodatabases-explored-vector-and-raster-data/
https://www.earthpoint.us/BatchConvert.aspx
https://www.earthpoint.us/BatchConvert.aspx
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To import data, open a blank map document and select a geographic (not projected) coordinate system, such 
as WGS 1984, in layer properties (see Figure 11 above). Under the File drop-down menu, navigate to Add 
Data->Add XY data. Browse and select the .csv file that contains your data, and choose the fields to specify 
latitude and longitude, if they are not automatically populated. 

Remember, latitude specifies the Y coordinate and longitude specifies the X coordinate. 

 

After the data have been imported, points should appear within the map file. Right click the layer in the Table 
of Contents and select Data->Export data and browse to the appropriate file location. This will allow you to 
create a shapefile from the imported table.  After that, the data can be projected to the project’s coordinate 
system.  

For more on importing tabular data, visit this link. 

 

3.4.2. Converting from .kml or .kmz files 
Google Earth data formats (.kml or .kmz files) can 
be converted for use in ArcMap/ArcGIS Pro using a 
built-in tool. In the Toolbox, navigate to 
Conversion Tools->from kml->kml to layer. Browse 
to select the input file and select the output file 
location. Once the file has been converted it can 
be projected to the project’s coordinate system. 

 

 

 

 

Figure 13. Example of tabular data layout as a .csv file in excel, prior to importing 
into ArcMap. Note ‘ObjectID’ column and latitude/longitude coordinates are in 
decimal degrees. From this table, each column heading will become a column in the 
new attribute table once in ArcMap. 

Figure 14. Example of converting from kml file to shapefile 
polygon. 

https://desktop.arcgis.com/en/arcmap/10.3/map/working-with-layers/adding-x-y-coordinate-data-as-a-layer.htm


 

 

3.4.3 Converting from AutoCad files 
In some cases, data will be delivered in 
AutoCad format, which will be 
recognizable by the .dwg extension. 
AutoCAD data may need to be 
georeferenced (you will notice this if the 
shapefile does not appear on the map). If 
that is the case, follow the steps outlined 
in 3.4.4. so that the features align with 
known reference points. Once they do, 
they can be exported to a shapefile. Each 
AutoCad file is comprised of a group of 
layers, one from each geometry (Figure 
15). Right click on the geometry that is 
depicted (for example, if they are points 
showing navigational aids, right click the 
point layer; these should have the 
symbology that you see on the map 
visible in the Table of Contents) and 
select Data -> Export Data and save as a shapefile.  It may be necessary to assign the resulting shapefile a 
coordinate system (Data Management Tools -> Projections and Transformations -> Define Projection) if the 
coordinate system is unknown. If the files were accompanied by an existing map or chart, assign the 
projection system noted on the chart (this is often printed on the chart itself) and then project it to the 
coordinate system for the project.   

Alternatively, once the AutoCad files have been georeferenced, they can be used as a template to create new 
features using the editing process described in the previous section.  

3.4.4 Digitizing data from other imagery 
Nautical charts and other maps can be rich sources of data, especially for features like navigational channels, 
mooring areas, or other delineations that may not be readily available as spatial data. Satellite imagery can 
also be used to digitize features that can be seen from aerial photos, such as the locations of piers, boat 
ramps, or other infrastructure (In the interest of time constraints – using Google earth to digitize these 
infrastructure features is recommended, where spatial resolution allows). Maps or charts can be used as a 
guide when digitizing these features manually, as long as they are in the correct format and they are 
georeferenced. If an image is georeferenced, it means that it contains information that ArcMap can use to 
assign a spatial location to the image in the map document. Images can be georeferenced if they are in one of 
the following formats: BIL, BIP, BMP, DAT, GIF, TIFF, ESRI GRID, IMG, JPEG, JPEG 2000, PNG. PDFs can be 
converted to TIFFs for georeferencing using the PDF to TIFF conversion tool (Conversion Tools->From PDF-> 
PDF to TIFF). 

In the first instance, determine if your image is georeferenced. This can be achieved by overlaying existing 
spatial data for features that are present in the image (e.g., navigational aid, shoreline) to see if they align 
with the image. Alternatively, a basemap can be added (File->Add Data -> Add Basemap) and compared to the 
image to assess whether they align. 

Even if the image appears to be properly georeferenced, it may need to be re-projected into the project’s 
coordinate system before creating any features based on it (see Section 3.3.1).  

Georeferencing 
If the image is not georeferenced, enable the georeferencing toolbar (Customize->Toolbars->Georeferencing) 
and add the image to your map document. Once the georeferencing toolbar has appeared, the image to be 
georeferenced can be selected from the dropdown menu (see Figure 16). Some images, especially if they are 

Figure 15. AutoCad files with a .dwg extension will have a group layer 
containing all geometries. To export the data to a shapefile, select the 
geometry type that can be seen on the map that corresponds with the 
symbology in the table of contents. 
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nautical charts, will list the coordinate system on the chart itself. If this is the case, change the coordinate 
system of the data frame to match that of the chart. If no coordinate system is apparent, it is often 
appropriate to choose a WGS 1984-based projected coordinate system such as 
“WGS_1984_Web_Mercator_Auxiliary_Sphere” while georeferencing, as this, corresponds to the imagery in 
basemaps and Google Earth. 

Find at least five spatially balanced locations (ideally more) on the image that you can use as control points. 
These should be points where the latitude and longitude at that point is known. Many maps have coordinate 
grids on the margins and/or graticule lines on the map which can be used to locate exact latitude/longitudes 
on the map. If these are not present, try to identify features on the image that are static in nature (e.g., 
headlands, docks, buildings, or other infrastructure) and locate those features in Google Earth imagery. 

Hover the cursor over target feature in Google Earth to obtain coordinates from lower right corner of the 
screen. Once the reference point is known, select the icon to the right of the drop-down menu in the 
georeferencing toolbar, and then click on the first control point on the map. Enter the coordinates in the pop-
up window. Then, repeat the steps for the second (and any subsequent) control points, before selecting 
“Update Georeferencing” from the Georeferencing drop-down menu. The image should now be adjusted to 
the correct location. Visit this link for more information on georeferencing in ArcMap.  

Once the image has been georeferenced, it can now be used as a reference when creating features. Before 
proceeding, ensure that the image has been projected into the project coordinate system and that the Data 
Frame matches the coordinate system (Section 3.3.1).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Create new features 
In some instances, new features may need to be created in the absence of appropriate data sets – for 
example, digitising marine infrastructure (i.e., wharfs, jetties, mooring areas, and boat ramps) using satellite 
imagery. To create new features, right-click the appropriate project folder or geodatabase in ArcGIS Catalog 
(ArcCatalog for ArcMap) and select new Shapefile or new Feature Class, and choose the appropriate geometry 
(i.e., point, line, or polygon). Ensure that the Editing toolbar has been enabled (Customize->Toolbars-
>Georeferencing), and in the Editor dropdown menu, select Start Editing. Select the newly created vector 
dataset to edit, and, if it does not show up automatically, open the Create Features window to select the 
dataset again (Editor Toolbar->Editing Windows->Create Features). You can now draw features on the map 

Figure 16. Use the georeferencing toolbar (ArcMap) to georeference images so that they can 
be referenced to create new features. 

https://desktop.arcgis.com/en/arcmap/10.3/manage-data/raster-and-images/fundamentals-for-georeferencing-a-raster-dataset.htm


 

 

using the imagery as a background reference. Attribute fields can also be edited during an editing session, as 
long as the attribute field has been added outside an editing session. 

3.4.5 Spatial interpolation of vector data to rasters 
Interpolation is a mathematical process that predicts the values for raster cells without a known value, based 
on surrounding known values (Burrough, McDonnell and Lloyd, 2015). The type of interpolation methods used 
will depend greatly on the characteristics of the underlying data, including the degree of spatial 
autocorrelation, the distribution of the data, the quality and resolution of the input data, the known 
bounds/knowledge of the system (i.e., known physical properties and behaviours of the variable being 
measured), the desired smoothness of the surface, and the study question/level of data quality required to 
answer this question. Choosing an interpolation method can be a complicated decision, and it is advised to 
critically evaluate and test different interpolation methods and parameters on your data to determine the 
best approach.  

Creating a ‘base layer’ 
Section 3.2 above outlined how to spatially define an area of interest. This polygon layer should now be 
converted into a raster ‘base layer’ to use in interpolations and other raster operations.  

One way to do this is to create a raster from the area of interest polygon created in Section 3.2. Ensure that 
the polygon is in the correct coordinate system and use the Polygon to Raster tool (Conversion Tools -> To 
Raster - > Polygon to Raster) to create a raster for the area of interest extent. In the Cell Size Field, specify the 
raster resolution that is established from Section 4.1. Here, the Cell Assignment Type can be left blank, assign 
the priority field column constructed in Section 3.5.3 to the Priority Field.  

When determining the cell size, it is important to make sure this is the same cell size that you wish to 
interpolate your vector data to. One good tip is to make a couple of base layers at the same time, with the 
different resolutions you’ll need throughout construction of the RSM (i.e., one cell size for your interpolation 
from vector data, and another for your final model outputs – if these are expected to be different). 

In some cases, there may already be a raster dataset (such as bathymetry) that fits the criteria for a reference 
base layer, in which case, it is fine to designate that as a base layer (Section 3.2).  

It is important to consider that the geoprocessing environment may need to be adjusted for some raster 
operations, with input field adjustments/considerations listed below 

Adjusting geoprocessing environments for raster operations: 

Extent: The Extent environment setting defines the features or rasters that will be processed by a tool. The 
tool will only process features or rasters that fall within the extent specified in this setting. The extent of the 
output dataset will typically be larger than the Extent setting to account for features or cells that pass through 
the extent rectangle. 

Mask: Geoprocessing tools that honour the Mask environment will only consider those cells that fall within 
the analysis mask in the operation. 

Cell size: Geoprocessing tools that honour the Cell Size environment set the output raster cell size, or 
resolution, for the operation. The default output resolution is determined by the coarsest input raster 
datasets. 

Snap raster: Geoprocessing tools that honour the Snap Raster environment will adjust the extent of output 
rasters so that they match the cell alignment of the specified snap raster. 

Generally, the other fields can be left blank or at their default values; however, it is good practice to review 
the Tool Help for each of the fields and decide whether these parameters should be adjusted based on the 
characteristics of the input data or the desired output data. 
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Spatial interpolation 

Interpolation is a statistical method by which known related values are used to help estimate nearby unknown 
values. There is no universally approved method of interpolation, the selection of a method will depend on 
specific data distributions, data characteristics, and the number of data points. Different interpolation 
methods can lead to different estimations of unknown data values, and therefore the creation of different 
maps, hence the selection of an appropriate interpolation method is key. Generally, Empirical Bayesian Kriging 
(EBK) method has performed well for interpolation of water quality data in the past and allows for automation 
of parameter selection for a range of kriging parameters that are otherwise difficult and highly technical to 
properly assign.  

However, in some cases, exploratory analyses may need to be conducted to find what interpolation method is 
most suited to a particular dataset. This was done for the Botany Bay estuary in NSW, Australia (see Case 
study: Botany Bay, New South Wales, Australia). The dataset constructed for water quality parameters was 
pulled from multiple data sources, and as such, had a different number of data points and different spatial 
arrangement of data points throughout the estuary, for each water quality parameter. The five water quality 
parameters investigated were salinity, temperature, dissolved oxygen, chlorophyll-a, and turbidity. 

Within the Geostatistical Analyst extension in ArcMap/ArcGIS Pro, spatial interpolation methods can be 
compared to determine which method is most suitable, using the Geostatistical Wizard. The process produces 
statistical indicators using cross-validation techniques, which can be compared between methods (Table 3). 
Comparing the results of interpolation methods with help from experts in the area of interest may be a 
helpful way of ensuring that the interpolation results reflect on-the-ground conditions. 

 

There are two broad groups of interpolation methods: 

Geostatistical: Utilises the statistical properties of the measured points to create surface and model the 
uncertainty or error in predictions  

Kriging (Geostatistical) – This method is a very powerful way to estimate surface values, especially 
when dealing with a sparse set of input point. This method delivers both a prediction value and a 
confidence value for that prediction. It generally works well for climate variables; however, it requires 
substantial analysis up front before the kriging process can be initiated. Typically, this involves 
generating a semi-variogram to determine whether spatial autocorrelation can be assumed. There are 
many different types of kriging to choose from depending on input data parameters.   

Empirical Bayesian Kriging (Geostatistical) – This method is very similar to the regular kriging 
interpolation method (above), but automates the more difficult manual adjusting of parameter models 
that are required in other kriging methods. Empirical Bayesian Kriging automatically calculates these 
parameters through a process of sub-setting and simulations, and this in turn enables more accurate 
predictions of standard errors as well as outperforming other kriging methods for small datasets. 

 

Deterministic: Simply creates surfaces from measured points. 

Splining - This method is often used when a smooth surface is desired, and when it is necessary for the 
predicted values to exactly align with input points. 

Inverse Distance Weighting – This method works well for highly variable data and assumes that the 
influence of a value will wane the further from the measured point. It works well with a dense set of 
input points and is a good choice if it is ideal to keep interpolated values within the range of input 
values.  

Topo to Raster (Deterministic) – This method is especially useful if the only available data on 
bathymetry is depth contours. Using the depth contour or point values, this method can create a 

https://pro.arcgis.com/en/pro-app/latest/help/analysis/geostatistical-analyst/understanding-a-semivariogram-the-range-sill-and-nugget.htm


 

 

hydrologically-correct digital elevation models. When using this method, it is helpful to constrain the 
boundary using coastline data or other feature boundaries to prevent prediction of on-land values.  

One of the most important considerations around interpolation is to not over-enhance the resolution of the 
underlying spatial data. For example, for sparsely populated input points, choosing a high resolution for the 
interpolated data product will exaggerate the reliability of the output surface. If there are not enough data 
points, you cannot interpolate. If there are enough data points, a general rule (assuming even distribution of 
data points) is that the resolution should be half the distance of the two closest points. For example, if the two 
closest datapoints were 100-m apart, 50 m would be a suitable raster resolution. 

It may be necessary to consult the input data’s metadata or provider to determine an appropriate resolution, 
it may also take some trial and error to find a balance between spatial resolution for smooth output and 
geoprocessing times. The issue of data and model resolution is discussed in more detail in Section 4.1. Note 
that interpolated data products don’t necessarily need to be the same as the model resolution, rather it 
should depend on the spatial spread of data points throughout the area of interest. More information on 
interpolation can be found here. 

If left unchecked, interpolation of vector data into a raster environment can propagate beyond the area of 
interest, which can both slow geoprocessing times and skew results. It is therefore good practice to define the 
bounds of an AOI in the ‘Environments’ tab, whenever working with raster data types.  

 

Common use cases of interpolation in RSMs 

Bathymetric data 
For some areas, raster datasets depicting bathymetry will be readily available for use as an input into the 
model. In other areas, bathymetry data may 
only be available as points (each with a value 
for a depth sounding) or contour lines, with 
each line depicting contours at specific depth 
intervals. The Topo to Raster tool (Spatial 
Analyst Tools -> Interpolation -> Topo to 
Raster) can be used to convert points or 
contour lines through a process of 
interpolation (Figure 17).  

In the Topo to Raster tool, select the contour 
or point data as the Input feature data in the 
first field (Figure 17). When the dataset 
appears in the table, select the field from the 
input data that contains the numerical depth 
values, and select the data type (these may 
auto-populate). For lines, choose “Contour” 
as the type, and for points, choose “Point Elevation.” The Output Cell Size field will automatically populate, 
but it may need to be adjusted depending on the desired model resolution (See Section 4.1. for more details 
on choosing an appropriate model resolution). 

  

Figure 17 Using the Topo to Raster Tool 

https://desktop.arcgis.com/en/arcmap/10.3/tools/spatial-analyst-toolbox/understanding-interpolation-analysis.htm
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Water quality data 

It is crucial to engage in early discussions with local 
catchment authorities/local councils/managers/ the 
Environmental Protection Agency (EPA) about the 
availability of water quality data for the region, as it can 
sometimes take a lengthy amount of time to finalize 
data agreements and physically obtain the data. 
Unfortunately, there may not always be sufficient water 
quality data to include in a habitat or restoration 
suitability model. In these cases, it is essential to engage 
with local stakeholders (from local council, 
marine/estuary managers, port authorities, and other local experts e.g. fishermen) and review scientific 
literature and estuary management plans to understand any water quality risks within an area. 

 

Where water quality data are available, the quality of this may vary. Some estuaries may have spatially and 
temporally intensive water quality sampling programs (e.g. Chesapeake Bay, USA), some estuaries may have 
hydrodynamic or biogeochemical models developed (this is the gold standard e.g. D'Entrecasteaux channel in 
Tasmania, Australia) or data available through remote sensing (e.g., turbidity or chlorophyll a data from 
satellite platforms) (Snyder et al., 2017), comparatively some estuaries may also have no or very little water 
quality data.  

If there is point data of water quality data collected for the area of interest, prior to interpolation, you should 
consider the following: 

What is the spatial and temporal sampling frequency of point data? 

Consider whether there are sufficient data points for interpolation, and if they are spread relatively 
evenly throughout the estuary. Consider whether the temporal frequency of water quality sampling 
may capture events that limit site selection (e.g., short sharp extreme events lasting 10 - 20 days or 
longer-lived extreme events lasting 1 - 2 months) 

What is the sampling regime and methods used for data collection? 

Consider how the number and spatial spread of datapoints relate to size and shape of the 
estuary/focal study area for the RSM. When interpolating this point data to a continuous raster layer, 
the distance between datapoints will determine what an appropriate raster resolution will be for the 
output raster maps. 

Figure 18. Mullet on Sydney Rock Oyster (Saccostrea 
glomerata) reef. Credit: Francisco Baena-Martinez. 

Case study: Gippsland Lakes (Victoria, Australia) 
The area of interest for shellfish restoration in Gippsland Lakes has water quality data collected by 
the EPA once a month at three sites, for the past decade. However, this data was not in a format 
suitable to integrate into the suitability model or at an appropriate spatial scale for spatial analysis. 
The sampling took readings of water quality parameters at multiple depths throughout the water 
column, rather than taking one sample at many sites throughout the area. These data, collected 
once a month, could not accurately capture the length or breadth of events that may limit site 
suitability throughout the estuary. This estuary experiences hypoxic events and long-lasting salinity 
stratification events, caused by a complex interaction of high-nutrient inputs into the estuary and 
high rainfall events. In this instance, by conversing with local experts, we were able to elucidate 
high-risk areas and alter the depth parameter criteria, to avoid placing a reef in those areas of higher 
risk.  



 

 

It is also important to consider how the data was collected. Consult metadata for each dataset 
acquired to understand data collection method, sampling regime and depth. From this you should be 
able to determine whether data is suitable for inclusion. 

Visualise the data set to assess whether there is substantial spatial or temporal variation of each water 
quality parameter in the dataset, and how this variation relates to the parameter criteria 

Simple line plots may be used to visualise how the parameter values changes over time. Consider 
whether there are key months/seasons that may limit site suitability, alternatively, there may be very 
little or no variation in one parameter, which may result in the whole area of interest receiving the 
same suitability score. If this happens, there is no reason to include the data for this parameter as it 
will not affect the final suitability map produced. 

How do you summarize water quality point data in a meaningful way? 

This process can be tricky, and will involve good working, local knowledge of the estuary, and what 
water quality events may limit site suitability. Some HSM/RSMs have in the past been constructed on 
monthly or annual means of water quality parameters (e.g., using an average of all recorded 
temperatures across a year, and applying parameter criteria/suitability scores to these averaged 
values). However, while this approach may offer rough idea about salinity/temperature gradient 
throughout the estuary, it is neglecting data indicative of shorter extreme events that may be 
formative in shaping shellfish distributions (e.g., summer heatwaves may be skipped over if only 
annual averaged temperatures are used). 

Another option is to create a model based on the most limiting parameters or based upon exceedance 
thresholds. For example, Theuerkauf et al., (2019) considered frequency of water flow events greater 
than 15 cm/s (i.e., the threshold flow value resulting in cessation of oyster feeding) in developing an 
RSM focused on water filtration services. Similar approaches for other parameters related to specific 
biology of the shellfish species of interest can be useful. For example, intertidal species in shallow 
waters may be disproportionately affected by heat waves, compared to subtidal oyster species. 
Frequency of heat waves (i.e., increase in seawater temperature above the upper 90th temperature 
percentile for a period of five or more days from a 30-year historical baseline) in place of mean water 
temperature may be a more informative parameter to include within an RSM (Hobday et al., 2016; 
Scanes et al., 2020). 

Ultimately, determining how to summarise water quality data prior to interpolation can vary largely 
between areas of interest, as many waterways/estuaries have very different characteristics and local 
conditions of which will lead to their own set of limiting parameters. 

Figure 19. Native Sydney rock oyster (Saccostrea glomerata) reef.                                  Credit: 
Francisco Baena-Martinez. 
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Figure 20. Continuous spatial layers of 
temperature (°C) (top) and associated 
standard error map (bottom). Maps are 
displayed for Sydney Harbour and Botany 
Bay estuaries, across June – January, 
non-spawning months. 

Case study: Botany Bay, New South Wales, Australia 
 

Four methods of interpolation were investigated (two 
geostatistical; Empirical Bayesian Kriging EBK) and Original Kriging 
(OK), and two deterministic; Inverse Distance Weighting (IDW) 
and Local Polynomial Interpolation (LPI)).  

Across validation technique (within the Geostatistical analyst 
extension) was used to evaluate and compare the accuracy of 
each interpolation method, for each parameter. For this 
technique, single observations were removed one at a time from 
the dataset, and the interpolation was performed again to 
generate an estimate at the location of the removed sample. This 
process is repeated at each datapoint for each cross-validation 
run, then the generated interpolated value can be compared to 
the true value to assess the accuracy of the model (Murphy et al., 
2010).  

 
Statistical criteria were generated from each cross validation run, 
to assess compare accuracy of different interpolation methods. 
For each water quality parameter, the accuracy of spatial 
interpolation methods was assessed on the basis of several 
statistical criteria: 

Mean Error (ME): the averaged difference between the measured 
and predicted value. 

Root Mean Square Error (RMSE): indicates how closely the model 
predicts measured value. 

Mean Standardised Error (MSE): represents the average of 
standardised errors. 

Root Mean Square Standardised Error (StdRMSE): indicates 
whether the predicted standard errors are valid, if this number is 
greater than one, the model has underestimated the variability in 
predictions, if less than one, variability is overestimated. 

Coefficient of determination (R2): is a statistical measure that 
measures the proportion of variation in the dependent variable 
that can be attributed to the independent variable, i.e., how well 
a statistical model predicts an outcome. 

https://pro.arcgis.com/en/pro-app/latest/help/analysis/geostatistical-analyst/performing-cross-validation-and-validation.htm


 

 

 

 

 

 

  

 

 

 

  

Case study: Botany Bay, New South Wales, Australia  
 

The model is considered most valid when the RMSE is as 
low as possible, the ME and MSE is near zero, and the 
closer stdRMSE and R2 is to one, the better the model fit 
(Bhunia et al., 2018, Chum et al., 2017, Murphy et al., 
2010, Njeban, 2018, Ohmer et al., 2017, Bronowicka-
Mielniczuk et al., 2019). 

EBK outperformed other kriging methods across all water 
quality parameters and thus was utilized for each spatial 
interpolation. Generally, EBK provides automation for 
selection of various kriging parameters that are otherwise 
difficult or highly technical to assign. Kriging interpolation 
methods may also use these statistical criteria to assess 
where predicted estimates of water quality parameters 
have the greatest uncertainty (Njeban, 2018). This was 
conducted for each parameter to produce a map indicating 
the standard error in predictions. 

Table 4. Example of geostatistical outputs for Botany Bay estuary, to assess the accuracy 
of each interpolation model on the basis of statistical criteria Mean Error (ME), Root 
Mean Square Error (RMSE), Mean Standardised Error (MSE), Root Mean Square 
Standardised Error (StndRMSE) and coefficient of determination (R2). Bolded numbers 
indicate the best performing statistic for each method investigated, for each parameter. 
Bolded method indicates the final method chosen to use for interpolation of specific 
parameter. * empirical transformation used with exponential detrended semi-variogram 
applied. 
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3.5 Applying parameter criteria to vector and raster data 
3.5.1 Sub-setting data 
For data in vector shapefile format, it may be 
necessary to select specific features from a 
shapefile to include in the analysis, based on 
their relevance to the model (either feature 
attributes or geographical location). 

Based on feature attributes:  

For example, the initial shapefile dataset may 
contain the location of all habitat types in a 
given region, but the model may only want to 
consider seagrass and rocky reef habitat. In 
this case, to make the data easier to visualize 
and work with in the future, it can be helpful 
to create a separate shapefile layer for each 
habitat type, and potentially within a single 
habitat type, based on different attributes 
(e.g., high- and low-density patches of 
seagrass). 

Based on geographical location:  

In some cases, shapefile datasets may also 
occupy a much larger geographical extent than 
the area of interest for the model. Removing 
areas outside the area of interest can be 
useful for cutting back on processing speeds. 
Either the ‘Select by Location’ tool or ‘Select 
by rectangle or polygon’ tool can be used to 
manually select features that fall in a specified 
area. Selected features can then be exported 
from the source layer to produce a new shapefile. 
Alternatively, the ‘Clip’ tool (Geoprocessing menu) can 
also be used to clip input data directly to the shape of 
the area of interest. 

 

3.5.2 Adding buffers and modifying vector attribute tables 
At this stage, it is useful to group shapefiles depending on whether or not they will have buffers added around 
features, and whether they will be included in the analysis or be included as an overlay on the final map. 

Not to be included in analysis: If shapefile features are intended to be only used as an overlay on the final 
map, once the shapefile is projected correctly, nothing further needs to be done. An example of this may be 
shapefiles containing Marine Protected Areas and restricted-use zones, whilst the location of these features 
should be considered to inform site selection, the development of associated parameters criteria and 
weightings is complex due to the challenges of negotiating exemptions of exclusion zones/habitat protection 
zones for restoration activities.  

To be included in analysis: Features included in analysis may or may not need to have buffers applied to them. 
If no buffers are required, skip this step and proceed to Section 3.5.3. 

Figure 21. Schematic demonstrating how parameter criteria 
may be applied to different types of vector and raster data. 



 

 

Applying buffers (i.e., setbacks) to avoid features of a vector layer is a useful way to minimize disturbances to 
sensitive habitats or avoid conflict with human uses or marine infrastructure, by excluding the area in close 
proximity to these features. Buffers can be simple, such as where an area outside a given buffer is appropriate 
for restoration and any area within the buffer is not. When a restoration project may benefit from being close 
to existing habitat, but there is concern that the restoration implementation may impact the existing habitat a 
more complex buffer approach can be used. This approach excludes area directly adjacent to the existing 
habitat but includes area at an optimal distance away from the habitat (see Figure 22). 

 

 

Simple buffers 
Examples of simple buffers are where local regulations require that restoration not take place within 500 m of 
a shipwreck or within 100 m of a mooring zone (Figure 22). 

First, consider the geometry type of the feature to be buffered. For example, if the area to be buffered is a 
water-skiing area, but it is represented by a line feature, the line will need to be converted to a polygon, either 
using editing tools or the Polyline to Polygon tool, otherwise areas inside the delineated area may not be 
included in the buffered area. 

To use the Buffer tool, navigate to the Buffer tool in the Geoprocessing drop-down menu. Input the feature to 
be buffered and enter the buffer distance (in this case of Figure 22, 50 m) into the Distance field, making sure 
to select the appropriate unit (Figure 23. Note that your features will need to be in a projected coordinate 
system before they can be buffered, so it is important to complete the steps in Section 3.3.1 before buffering 
any features.  Although not specifically required for simple buffers, setting a dissolve type of “All” is good 
practice. Other default settings can be left as they are.  

Multi-ring buffers 
When working with a more complex buffering system, a multi-ring buffer tool may be used. For example, the 
seagrass depiction in Figure 22, and geoprocessing example in Figure 23. The Multi-ring buffer feature works 
in much the same way as the simple buffer tool but allows the user to input multiple distances in at the same 
time. 

Simple buffer                   
(Conflicting estuarine uses) 

Multi-ring buffer                   
(Other complex habitats) 

Figure 22. Examples of a simple buffer used around a mooring zone (left) and 
complex/multi-ring buffer used around seagrass beds (right). 
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3.5.3 Modifying vector attribute tables 
At this stage, if no further modifications of vector data are required, it is time to start modifying attribute 
tables of vector data sets, before converting them to raster format. In this step, two additional fields in each 
attribute table need to be constructed, a ‘Score’ field and a ‘Priority field column’. 

Creating new column in an attribute table 
Create a new attribute field by right-clicking on the dataset in the table of contents and selecting Open 
Attribute Table. In the attribute table, click on the icon in the upper left corner and select Add Field. Give the 
field a name such as “Score” and select “Short Integer” from the drop-down menu.  There may be other 
reasons why it may be helpful to add attribute data columns, in which case, use this guide to help determine 
which field type is best.  

Score column 
Here is where the parameter values identified in Section 2.4.1, are applied to spatial features. In the 
newly created ‘Score’ column, parameter vales/scores can be typed directly into the cells if an editing 
session is open, but if there are many features with the same score, it is good practice to select groups 
of features that will have the same score using the Select by Attribute tool, right clicking on the 
column, and selecting “Field Calculator”. In the field calculator, you can enter the score for that 
category of features in the window, and it will assign that value only to the selected feature. It is best 
practice to make sure every feature has a score otherwise errors can occur during raster processing. 
Having scores of 0, can also cause some errors to occur during the raster processing, it is therefore 
best to assign a “dummy” score for features without a score (e.g., 99999, or any other number that will 
not be confused with a valid input score) that can be corrected during the raster reclassification 
process outlined in Section 4.4. 

Priority field column 
This is also a good time to add a “Priority Field Column” which can also prevent errors during raster 
conversion. In another data column, use the steps described in the previous paragraph, to assign all 
features a value of ‘1’. 

Figure 23. Parameters for applying a simple buffer to features in ArcMap (left) and using a multi-ring buffer in ArcGIS Pro 
(right). 

https://desktop.arcgis.com/en/arcmap/latest/manage-data/geodatabases/arcgis-field-data-types.htm


 

 

 

 

4. RASTERS AND MODEL CONSTRUCTION 

Once all feature data layers have been prepared for each of the model parameters to be included within the 
RSM, it is time to create the input rasters for the model. This is achieved in three stages – 1) Deciding upon 
the desired resolution of the final model, 2) Converting all vector layers to raster format, and 3) Reclassifying 
all raster layers to reflect pre-defined suitability scores. 

4.1 Defining model resolution 
There is no standardised rule for determining model resolution. Generally, this requires striking a balance 
between the spatial precision of the input data, the size of the area of interest, the project’s siting needs, and 
the size of buffered polygon features. Ultimately it is up to the discretion of the modeler in consultation with 
end-users of the model to determine the appropriate resolution for the model. It can be useful to discuss 
spatial resolution with other colleagues who work in the GIS space. 

While higher resolution models are generally preferred, if input data are not themselves of high spatial 
accuracy, the predictions of a fine-scale model can be misleading. It is important to remember (and remind 
end-users) that while models provide guidance as to where restoration projects should be considered, they 
are not typically intended to identify an exact location for restoration, but rather provide guidance as to 
where field verification activities should focus their efforts. This method saves time, money, and increases 
chances of restoration. 

As shapefiles and other feature data (e.g., polygons, polylines) can adapt to any spatial resolution when 
converted to a raster format, it is often instructive to use any input data derived from imagery (e.g., 
bathymetry or benthic habitat) as a baseline for what raster resolution is appropriate. Consult the metadata 
for these datasets for information on resolution. 

Some of the following case study examples below (also see Aguilar-Manjarrez et al., 2018), may provide 
guidance in determining a suitable resolution for future planned RSMs. 

Figure 24. Adding a field to an attribute table (left) and modifying the attributes using the Field Calculator 
in ArcMap (right). 
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Case study: Gulf St Vincent, Adelaide (South Australia, 
Australia) 
Restoration suitability modelling in Gulf St Vincent was 
conducted to identify potential sites for native Ostrea 
angasi oyster reefs. The area of interest was quite large, 
at > 2,000 km2, and the available bathymetry data’s 
resolution was ~250 m. For this model, a 50 m resolution 
was chosen. Although using a finer resolution than the 
input bathymetry is not always best practice as it can 
artificially enhance the resolution of the RSM results and 
introduce error, in this case, the field verification 
activities that were planned based on the model outputs 
justified the re-scaling of the input data to a finer 
resolution. 

 

Case study: Botany Bay (New South Wales, Australia) 
Habitat and restoration suitability modelling was conducted for Botany Bay to guide site 
verification efforts for the restoration of native intertidal Saccostrea glomerata and subtidal 
Ostrea angasi oyster species. 

For this estuary, there were two different raster resolutions used in the HSM construction, but 
the final model required a single resolution. Water quality data had a raster resolution of 50 m, 
and bathymetry data had a 10 m resolution. Water quality rasters at a 50 m resolution were 
resampled to a 10 m resolution (Figure 25). Similarly, to the Adelaide model (previous case 
study), it was desirable to maintain the 10 m bathymetric resolution, rather than lose important 
spatial information by selecting a coarser spatial resolution. However, this typically is not a best 
practice without careful consideration as it can artificially enhance data quality and introduce 
error. 

The RSM constructed for Botany Bay, incorporated small data features <10 m. In this case, to 
maintain these small data features, the HSM were resampled to a 1 m grid size, to allow for 
easier incorporation with these smaller, complex spatial features, rather than risk losing that 
information if the resolution of the final model was lower. 

Whilst this did increase geoprocessing times, it was appropriate for this estuary, given high 
spatial complexities. In other less complex and larger areas of interest this approach may not be 
appropriate. 

 

Figure 25. Graphic illustrating the 
resampling to a smaller raster size.  



 

 

4.2 Converting polygon and raster data to model input rasters 
From polygons 
Data inputs that are in vector format will need to be converted to rasters. Most input datasets will likely be 
polygons and can be converted to rasters as described in this section, but lines and points can also be 
converted to rasters using the tools in the Conversion Tools toolbox (Conversion Tools -> To Raster).   

If the parameter values have already been assigned to the features, as described in Section 3.5.3 the field with 
the parameter values can be selected for the Score field. If values have not yet been assigned, that can be 
done in subsequent steps (Section 4.4), choose the column that best describes the parameters that will be 
classified (i.e., if this is a benthic habitat dataset, choose the field that delineates the habitat types). 

To ensure that all input rasters can be overlaid with one another to create the final model, it is necessary to 
ensure that their extent, resolution, and grid structures align. Use the Environment Settings (as described in 
Section 3.4.5) to match the output rasters with the reference base raster.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Figure 27. Using the Polygon to Raster tool in ArcMap. 

Figure 26. Using the Raster Analysis Environment Settings in ArcMap. 
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From rasters 
If any of the input data layers are rasters, it is necessary to modify it to match the attributes of the reference 
dataset from the previous section.  If the raster is not already in the project’s coordinate system, project it 
using the Project Raster tool (Data Management Tools -> Projections and Transformations -> Rasters -> 
Project Rasters). Then, use the Resample Tool (Data Management Tools -> Raster -> Raster Processing -> 
Resample) to adjust the resolution so it matches the grid cell size determined in Section 4.1. In the Output Cell 
Size Field, select the reference dataset and the X, Y fields should automatically populate with the grid 
resolution.  In the Resampling Technique field, choose Nearest if the input raster is made up of categorical 
data (e.g., benthic habitat types) or Bilinear if the input data are continuous and numerical (e.g., depth).  

Before clicking “OK”, it is possible to save a step by “snapping” the output raster to the reference data, so that 
the resulting grid cells will be in alignment (Section 3.4.5). In the field for Snap Raster, choose the reference 
raster in the drop-down menu and click “OK”. Then, click “OK” again to run the tool. The result should be a 
grid whose cells align with and are the same size as the input raster. It is also helpful to set the extent as the 
base/reference layer here, so the resulting raster will only cover the project extent. This is not strictly 
necessary, but it is often advisable, especially if the raster is large, to increase the speed of subsequent 
geoprocessing steps. 

 

4.3 Categorizing input rasters (binary and gradient) 
Model parameters typically fall into two separate categories, binary and gradient (see Section 2.4.2 Parameter 
weights). Binary parameters depict features in which some areas are completely restricted, and others are 
not. There are only two suitability scores in binary parameters, one of which is zero. Examples of binary 
parameters include shipping lanes, navigational buoys, shipwrecks, and any other areas where restoration 
projects would be completely restricted.  

Gradient (non-binary) parameters depict features that are scored on a continuous or categorical suitability 
scale and are generally all parameters that do not fall into the binary category of scores equalling zero or one. 
Gradient parameters have a larger range of suitability scores used for each parameter. Examples of gradient 
parameters may be proximity to complex habitat (e.g., seagrass), salinity and depth. It is critical to identify the 
category for each of the input variables in preparation for the next step. In some RSMs, binary and gradient 
parameters are considered as separate sub-models that are subsequently integrated (e.g., all binary 
parameters included within a constraints-based ‘exclusion analysis’ sub-model, and all gradient parameters 
included within a sub-model – see Puckett et al.,  (2018)).  

 

4.4 Reclassifying rasters 
In the reclassification step, input rasters are re-assigned parameter scores reflective of defined suitability 
relationships based on the ranges of suitability scores for each model parameter defined in Section 2.4.2. The 
process of reclassifying rasters to suitability scores may utilise continuous (Barnes et al., 2007; Puckett et al., 
2018; Chowdhury et al., 2019) or discrete (i.e. integer) (Lewis, Fox and DeWitt, 2019) scales. The scale used to 
reclassify each raster is dependent on the parameter type and having sufficient knowledge with which to 
define relationships between target shellfish species and parameter raster to be reclassified. 

Binary type parameters must use the discrete reclassification approach, whereas gradient parameters may 
use continuous or discrete approach. 

This process should be repeated for every input dataset until there is a reclassified raster for every model 
parameter.  



 

 

Discrete reclassification 
This method of reclassification is the simplest approach and is primarily used when there is insufficient 
knowledge of relationships between each parameter and suitability for restoration to allow for the use of a 
continuous scale. Discrete suitability scores for each parameter are often set based on the biological 
tolerances of shellfish species following an extensive literature search.   

Discrete reclassification is done using the Reclassify tool (Spatial Analyst Tools ->Reclass ->Reclassify).  Using 
the Reclassification table in the Reclassify tool, these scores are assigned to the value ranges (Figure 28). 
[Note that depths are often stored as negative values, as seen in this example]. ‘NoData’ can be used to define 
areas to not include in the analysis, but generally it is good practice to have a numeric value (like zero) for all 
excluded depths within the study estuary so that you have a complete surface. 

For example, the ranges of suitable depths for our focal species are as follows: depths above 3 m are 
unsuitable (score = 0), depths between 3 – 6 m are optimal (score = 4), between 6 – 9 m are moderately 
suitable (score = 2), and depths below 9 m is unsuitable (score = 0). 

 

The reclassification tool should also be used for datasets delineating areas where restoration projects will be 
prohibited. For example, Figure 28 and Section 3.5.3 describe a scenario where a shapefile is converted to a 
raster, but the feature’s score column is not assigned 0 at that stage as it would cause errors in the raster 
conversion process. In this case, the Reclassify tool can be used to reassign the navigation channel area to 
zero and assign all other areas within the area of interest a non-zero value (Figure 28). 

Continuous (linear and non-linear) reclassification 
Where relationships between individual parameters and suitability for restoration are well-characterized, 
continuous functions to define suitability can be developed and applied. Continuous functions are valuable in 
providing a broad range of suitability scores along a gradient, allowing for strengthened contrast in 
restoration suitability across a study area relative to binary (two choices, suitable vs unsuitable) or categorical 
approaches (e.g., a few choices).  

Figure 28. Snapshot of reclassify tool being used to reclassify a bathymetry layer based on suitability 
criteria (left), and a depiction of a before and after of the reclassification process (right) in ArcGIS Pro. 
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To develop a continuous reclassification function, it is important to understand the form of the relationship 
between an individual parameter and suitability for restoration as derived from available scientific literature 
and/or expert input. For example, Theuerkauf et al. (2019) developed ecosystem services-centric restoration 
suitability models for Pamlico Sound, North Carolina and developed individual suitability functions for 
parameters based upon established relationships between individual parameters and oyster water filtration 
capacity from the literature. In developing a suitability function to relate mean water flow velocity to oyster 
water filtration capacity, the available literature indicated a non-linear relationship would be appropriate, 
whereas a positive linear relationship would be appropriate for minimum observed dissolved oxygen 
concentrations (Figure 29). 

In the case of linear relationships, a 
simplistic linear regression function 
can be defined within Microsoft Excel 
(Figure 29) to determine the 
relationship between raw raster values 
for an individual parameter (e.g., 
dissolved oxygen ranging from 2-8 
mg/l) and suitability (e.g., ranging from 
0.0 - 1.0).  

The resultant equation can be used 
within Raster Calculator to assign 
continuous suitability scores along the 
range of 0 - 1 for the individual 
parameter. 

The same process can be applied for 
other functions (e.g., non-linear 
functions, such as the example of 
suitability relative to mean water flow 
velocity above). Resultant equations 
can be passed through Raster 
Calculator to define and assign 
suitability. Careful attention should be 
paid to the use and application of 
appropriately supported functions to 
define suitability relationships based 
on available supporting scientific 
literature or expert input. 

Alternatively, the following equation 
can be directly modified to avoid the 
excel step: 

For 0-1 normalization: 

X’ = (x – min(x))/(max(x) – min(x)) 

 

  

Figure 29. Example of continuous linear and non-linear reclassification of input 
data in excel. 



 

 

4.5 Calculating RSM 
The final RSM is a combination of two separate sub-models, the binary model (also known as constraints-
based analysis or exclusion analysis) and the gradient model (Figure 30). These are calculated separately to 
reduce geoprocessing times and the risk of data handling errors. 

Use the Raster Calculator (Spatial Analysis Tools->Map Algebra->Raster Calculator) to create each sub-model 
and the final model (Figures 31-33). 

Binary sub-model 
The binary sub-model will include all the binary 
input rasters that are on a suitability scale of 0-1 
(i.e., an exclusion layer, of areas where restoration 
activities are not permitted). 

The resulting raster will show all areas in your focal 
system where restoration is restricted, making a 
handy tool for planning and decision making. 

Multiplication: 
Exclusion layer = Mooring exclusion zones × water 
skiing exclusion zones × recreational swimming 
exclusion zones.  

Gradient sub-model 
When calculating the gradient sub-model, there are 
at least two (probably more) potential equations to 
use for a 3 parameter model. 

Multiplication: 
HSM = Salinity × turbidity × depth 

Geometric mean: 
 

 

 

The benefit of the geometric mean, is that the model output retains the same scale as all the input features. 
Whereas, if multiplication is used to calculate the final model, this may need to be rescaled back down to the 
original suitability scale of 0 to 4. Additionally, the use of the geometric mean ensures that if a given cell is 
assigned a score of ‘0’ for an individual parameter, it will retain a score of ‘0’ for that location within the final 
RSM. 

When incorporating the conflicting use and logistical restrictive layers (i.e. proximity to moorings or navigation 
channels), it logically makes sense to exclude these areas – which is why a buffer zone of exclusion (score = 0) 
is established around them. However, beyond these exclusion zones, there is no physical or ecological benefit 
to shellfish being restored there. For this reason, it makes sense to use these areas purely as an exclusion 
layer and on a scale of 0 to 1. 

  

Figure 30. Schematic describing how binary and gradient 
sub-model are constructed and combined to a final model. 

HSM = �Salinity ×  turbidity ×
depth

3
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Final model calculation 
For our 3 parameter model example the final RSM would be produced using the raster calculator by 
multiplying the binary/exclusion and gradient sub-models together. 

So, the final model calculation would look similar to this: 

 

RSM = �Salinity ×  turbidity ×
depth

3
×  (exclusion layer) 

 

  

Figure 31. Example of calculating the geometric mean within the raster calculator of 
ArcGIS Pro. 

Figure 32. Example of multiplying all the relevant input rasters together in the raster 
calculator of ArcMap. 



 

 

4.6 Incorporating weights into RSM calculation 
Parameter weightings may also be incorporated into a restoration suitability model, assuming that there is 
sufficient information with which to determine these values. Weightings may be added into the equation in 
the Raster Calculator step, in the example below the bathymetry layer is given a weighting of 70% and the 
slope layer is given a weighting of 30%. Weightings may be included in decimal or integer form, as long as the 
sum of the weightings is equal to the value of the denominator in the final fraction (Figure 33). 

  

Figure 33. Example of calcualting the geometric mean with parameter weightings applied within the raster 
calculator of ArcGIS Pro. 

4.7 Using Suitability Modeler in ArcGIS Pro 
Those with access to ArcGIS Pro software may wish to consider completing steps 4.4 - 4.6 using the 
Suitability Modeler tool. Preparing the data for use in the suitability modeler generally follows the 
same workflow articulated in this section; however, the suitability modeler provides a more 
interactive environment allows the user to see, on the fly, the impact of each input on the model. It 
also allows for on-the-fly adjustments of model weights and suitability scales without having to 
create many different versions of the model inputs. Finally, the user can set parameters for 
recommended areas by setting minimum and maximum sizes, ideal shapes, and minimum and 
maximum distances among proposed sites. Following the above workflow, users can apply 
classifications and weights to the "gradient” data categories and use the binary data category as a 
mask in the final step to exclude any areas that are completely unsuitable for the project. 

While this tool shows promise for streamlining the workflow, this tool has not been tested against 
the approach outlined in the rest of this document. Preliminary experience with the tool suggests 
that data preparation requirements can be very precise – even more so than the requirements 
presented in this manual. Furthermore, at the early stages of restoration suitability modelling, it 
may be preferable to produce a map of all possible locations, rather than just the optimized site 
locations, as further site verification may be needed. Users considering using this tool are 
encouraged to test the results of this tool against the approach outlined in this manual and 
determine which approach works best. Learn more about the suitability modeler widget here.  

https://pro.arcgis.com/en/pro-app/latest/help/analysis/spatial-analyst/suitability-modeler/implement-the-suitability-modeling-workflow-using-the-suitability-modeler.htm
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5 NEXT STEPS TO UNDERTAKE AFTER DEVELOPING A RESTORATION 
SUITABILITY MODEL 

After developing the habitat or restoration suitability model, there are a few important steps to take to 
ensure that final restoration sites are selected with confidence based upon the guidance provided by the 
model. These include undertaking: (1) model verification/validation steps, (2) conducting ground-truthing 
exercises to survey potential sites, (3) engaging with stakeholders to further refine potential sites, and (4) 
producing a report summarizing model outputs and findings. 

5.1 Model verification and validation 
To determine the reliability and utility of a habitat or restoration suitability model produced, it is important to 
assess the accuracy of the model. Generally, to implement a model with confidence there is four-step process 
that should be undertaken: development, calibration, verification and validation (Brooks, 1997; Theuerkauf 
and Lipcius, 2016). 

Development refers to the application of wildlife-habitat (or logistical) relationships to spatial datasets. This is 
part of developing the parameter criteria and raster reclassification steps which we’ve already completed in 
previous sections. 

Calibration ensures that the index/suitability scores of the model span the entire width of potential values 
(e.g., ranging from 0.0 to 4.0), to allow sufficient distinction in describing differences among sites. Calibration 
also enables ease of comparison of models generated for the same shellfish species across different 
geographies, provided the models are on the same suitability scale. 

Verification requires the assessment of suitability model outputs against independent qualitative or 
categorical (ranked) data. For example, a presence/absence dataset for shellfish in a given estuary, could be 
used to provide verification by assessing positive or negative correlation to the model outputs.  

Validation involves testing the model outputs against independent quantitative data. To the extent feasible, 
validation should be a priority exercise for developing an HSM or RSM as it provides the greatest measure of 
model validity and predicted reliability for informing siting decisions. It is essential that data used for 
validation are fully independent of data used within the suitability model—use of non-independent data (e.g., 
use of oyster density data within an HSM/RSM and re-use for validation) can lead to circular logic. 

Typically, validation assessments involve regression analyses of model outputs (e.g., suitability scores) against 
independently collected population density or abundance datasets for corresponding locations (Theuerkauf 
and Lipcius, 2016). These independent data can be purposefully collected (e.g., survey of locations post-
HSM/RSM development), or leverage independent, existing datasets (e.g., reef monitoring efforts by a state 
resource agency). Where there is potential for new data collection, it is valuable to conduct a priori 
assessments of minimum sample sizes required for statistical power to identify statistically significant 
correlations (e.g., R2), as well as to randomly sample locations along the full spectrum of predicted suitability 
(i.e., unsuitable, marginally suitable, suitable). 

Metrics used for validation should correspond with those relevant to the developed RSM. For example, if the 
RSM is developed to identify locations that are likely to maximize population recovery, then oyster density 
would be a relevant dataset for validation. The form of the relationship between suitability and independent 
datasets used for validation may vary (e.g., linear, non-linear), but should generally be positive. A lack of 
correlation or relationship between suitability scores and the data used for validation may indicate a missing 
parameter (e.g., dissolved oxygen) within the RSM that must be addressed before it can be reliably used for 
restoration siting. If validation of model outputs has already been achieved, verification is not required.  

Whilst each of the above four steps will help assess the accuracy, reliability and usability of the output, the 
reality is not every restoration project is going to thoroughly test the integrity of model outputs, and largely 



 

 

depends on local data and resource availability, and time constraints of the project. There are some additional 
strategies outlined below, that may provide a suitable work-around for where project time or resources are 
constrained. 

5.1.1 Comparison to historic or current shellfish distribution maps 
One of the simplest ways to verify suitability model outputs is to compare to a shellfish distribution map. 
However, the utility of this approach will depend on data availability across the study area. Caution is advised 
when using historic shellfish distribution maps, particularly if the study area has undergone substantial 
modification or urbanization, as sites once suitable for shellfish reefs, may no longer be suitable due to 
changed hydrology or water quality condition. It is also important to consider the level of completeness of 
shellfish distribution maps available for your study system – absence of available data does not necessarily 
equate to absence of shellfish presence; it may be the case that not all areas have been surveyed. If time 
allows undertaking assessment trials of the target species examining growth, survival and/or condition, across 
the highly suitable areas identified in by the RSM 
may be beneficial. This approach allows the project 
group to understand contemporary success of the 
target species as opposed to historical success. 

5.1.2 Ground-truthing with site-specific surveys 
The most common and practical way to assess the 
accuracy of suitability model outputs for the purpose 
of on-ground restoration work, is to conduct 
targeted site surveys. Where resources are available, 
it is a good practice to survey areas along the full 
spectrum of suitability (including unsuitable (score = 
0), moderately suitable (score = 0 to 3), and highly 
suitable areas (score = 3 to 4) to evaluate accuracy of 
model predictions. 

For example, when developing an RSM for Pamlico Sound, North Carolina, USA, researchers conducted 
ground-truthing of an early draft RSM that omitted a dissolved oxygen layer and noted that locations 
predicted as highly suitable exhibited hypoxic conditions. The ground-truthing identified the importance of 
developing a novel dissolved oxygen layer and integrating it within a revised RSM for the system to improve 
quality of the RSM predictions for informing restoration siting. 

However, where time and resources are limited, the project team may prefer to focus site surveys on areas 
that appear in the model as moderately to highly suitable. Site surveys may be done by the team or through a 
contractor. Different methods of site surveys will vary on the type of data needed to be collected and depth of 
target sites. Generally, it is important to collect information for each site on substrate firmness, sediment 
type, presence of other habitat types, depth (subtidal), proximity to other features, and sulfur-smell in the 
sediment etc.  

Intertidal reef site surveys will often need to be accessed by boat, but the surveys can be done on foot at low 
tide. Whereas surveys for subtidal reef sites will require towed video cameras, or a dive team to assess the 
site and collect samples, if required. 

Figure 34. Native Sydney rock oyster (Saccostrea glomerata) 
reef. Credit: Alice Howie. 



 

 

 
The restoration suitability model for Port Phillip in 
Victoria, Australia required a focussed site survey 
to be completed around the southern site of 
Dromana. Initially, the project team undertook 
SCUBA surveys of two 5-ha areas from the highly 
suitability area identified by the RSM (Figure 35). 
These initial surveys were observational surveys 
that identified higher than expected amounts of 
seagrasses (mixed Zostera nigricaulis and Halophila 
australis beds), that if mapped and included in the 
RSM would have excluded the area. Following from 
these findings the project team engaged an 
environmental consulting firm to complete a rapid 
habitat mapping and ground truthing survey of the 
Dromana Bay region (Figure 35) with a particular 
focus on the identification of seagrass habitats that 
were not currently mapped.  

Initially, seabed features and survey areas of 
interest were identified (western, central and 
eastern sectors – Figure 36A) using a combination 
of LiDAR (Light Detection and Ranging) reflectance 
and bathymetry (depth limited to <12 m as this 
depth represents optimal limits for future SCUBA 
diving operations for monitoring) both datasets 
were readily available from the state government.  

Transects were completed over the seabed 
features using a Remotely Operated Vehicle (ROV) 
with underwater positioning (Figure 36A). The 
‘outbound’ leg of transects ran at low altitude 
allowing detailed inspection of features and the 
inbound leg at higher altitude (1.5 m) for overall 
biotope views and still image capture. Tracks were 
classified using the Victorian Government 
Combined Biotope Classification Scheme (CBiCS). 
Seagrass beds were digitized using thresholds of 
reflectance values and hand-digitization for 
nearshore seagrass beds in the eastern sector 
(Figure 36B) due to interference from shoreline 
waves, cliffs and manmade structures. The 
seagrass bed in the eastern sector of the bay was 
confirmed from two historic towed video transects 
intersecting the feature. 

 

Figure 35. The final RSM model output for Dromana, 
showing highly suitable region in orange and the North 
and South 5 ha areas as green rectangular polygons 
where initial ground-truthing site surveys were 
undertaken. 

A 

B 

Figure 36. A) Study transects in the survey areas in Dromana 
Bay (western and central sectors) and seagrass bed in 
eastern sector showing surveyed seabed features (inset: 
LIDAR reflectance). B) Biotope classification from transects 
and mapped extent of seagrass and sediment biotopes in 
Dromana Bay. 

 



 

 

Outcomes from the survey were that three biotopes were mapped (Figure 36B) and a seagrass free area of 
moderate suitability was identified for shellfish reef restoration (Figure 37). Additionally, the surveys 
confirmed previously unmapped Zostera nigricaulis seagrass beds in the Dromana Bay region. The bed in 
the eastern sector is expansive and is the largest intact bed in this region of Port Phillip. Within the other 
survey sectors (western and central) the seagrass beds were arranged in dendritic patterns perpendicular 
to shore. These features continue outside of the surveyed sectors for 10s of kms further along the coastline 
of Port Phillip and if the observed pattern holds true would contribute a significant and unmapped 
expansion of known seagrass beds in Port Phillip adding substantially to the marine estate of the state of 
Victoria. 

 

 

  

Figure 37. Final location of Dromana reef and 5 ha restoration permit area with final RSM 
output and mapped seagrass (Inset = Dromana reef oyster reef patches and 5 ha restoration 
permit area in greater detail). 
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5.2  Stakeholder engagement  
The first principle underpinning ecological restoration is ‘ecological restoration engages stakeholders’. 
When conducting site surveys, or shortly thereafter, it is time to engage local community stakeholders to 
present potential restoration sites and document feedback to integrate into the suitability model. Engaging 
with the local community early on allows for the candidate restoration sites identified during modelling to 
be discussed and further vetted, gaining input and consensus among stakeholders. This process ultimately 
will assist in narrowing down final suitable sites. Community groups such as recreational fishers, 
birdwatchers or conservation groups are often valuable to engage, as they often have deep institutional 
knowledge of what is currently happening in the estuary and can speak to other tidal, seasonal, annual 
events and variations in water quality, sediment movement, hydrology and habitat variation. Other 
stakeholder groups recommended for consultation are the Department of Transport and Local Council 
groups, visit Appendix B below for more information on conducting stakeholder engagement work. 

5.3 Communicating modelling results 
Suitability modelling report 
Having constructed and completed restoration suitability model runs, it is important to be able to 
communicate the modelling results to other team members and organisations, who possess a range of GIS-
based knowledge. An RSM report should provide sufficient information for readers to understand how the 
model was constructed (without being overly technical), as well as an overview of the results and 
assessment of whether there are any caveats or limitations of the model. Below is a list of components that 
can be included in a report. 

• Project background and context (e.g., study area, focal species, scale, planning objective) 
• Parameter criteria (e.g., justification and references) 
• Map of model output 
• Table detailing model output (summarising percentage and total area classed in each suitability 

category) 
• Brief description of model outputs 
• Detail on any model validation/verification steps that were done 
• Detail on any ground-truthing exercises conducted 
• Detail on any stakeholder engagement activities that assisted in narrowing down potential sites 
• Site description of shortlisted sites with which to proceed with  
• Caveats or limitations of the model 

Displaying modelling outputs online 
Early in the modelling planning process, it is good practice to discuss with the broader project team what 
the physical outputs of the suitability model are needed and who the end-users of the product are. Often 
alongside the RSM report, there is a need for a few static maps to share with partners and communicate 
with stakeholders. The use an interactive and online web-based mapping is becoming increasingly popular 
as a way to communicate with the broader stakeholder community (Figure 38). 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6 LIMITATIONS AND FUTURE DIRECTIONS 

Restoration suitability modelling is in an everchanging state of evolution and improvement, with new 
methods, tools, and technologies being developed and leveraged. Below we discuss new horizons for 
modelling methods and approaches, the utility of emerging technologies, and the role of other tools. 

Each model discussed herein has limitations, largely dependent on the locality that the restoration project 
is poised to take place. A common limitation is insufficient data available to meet desired or target 
restoration suitability modelling outcomes.  Funding can also be a potential limitation for future monitoring 
of restoration projects and the ability to validate the model. 

6.1 New modelling frameworks and methods 
Targeted ecosystem service models  
Typically, the goals of shellfish reef restoration 
projects extend from reinstating a particular 
shellfish population or habitat area for the target 
species, to the provisioning of specific ecosystem 
services (McDonald, Jonson and Dixon, 2016). 
Ecosystem service-based goals may include 
shoreline stabilisation, wave dissipation, water 
filtration, enhancement of fisheries 
productivity/harvest and provisioning of habitat to 
fish and invertebrate communities (La Peyre et al., 
2015; Gilby et al., 2019; Theuerkauf, Eggleston and 
Puckett, 2019). The methods outlined in this 
manual will guide a user on how to construct a habitat or restoration suitability model for shellfish reefs, 
based only on the feasibility of restoration as determined by the parameters and criteria chosen. 

However, to further refine sites, or target sites that will likely have a good outcome for certain ecosystem 
services, additional parameters (and parameter weightings) may need to be applied which align with 
specific targeted ecosystem services. For example, if the goal is fisheries enhancement, it may be 
particularly important to ensure the site chosen for restoration is connected to other essential fish habitats 
in the estuarine seascape mosaic, such as mangrove, seagrass, and saltmarsh (Gilby et al., 2018, 2019). 

Figure 38. Example of ArcGIS Online web map app showing the restoration suitability model for Port Phillip Bay. 

Figure 39. Saccostrea glomerata and mangroves growing 
together. Credit: Francisco Baena-Martinez. 
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Consequently, proximity of sites to other estuarine biogenic habitats may have higher relative weights in 
the model. 

Whilst there has been some noteworthy ecosystem service-targeted restoration suitability models 
produced for shellfish reefs (Theuerkauf, Eggleston and Puckett, 2019), these types of models are expected 
to become more important and used in the future. The ability to target specific ecosystem services in a 
model will be of the utmost interest to local stakeholders, partner organizations, and project funders, 
building confidence in project outcomes. 
 

Table 5. Example table showing TEEB ecosystem types, and highlighting specific ecosystem functions, processes, ecological 
benefit and parameters for consideration that could be included in a targeted restoration suitability model. 

 

Larval dispersal and metapopulation modelling 
A common issue in shellfish restoration work is identifying a source for shellfish larvae. If the target 
shellfish species is not present in the estuary system, live oysters are often ‘seeded’ on the reef substrate 
directly by divers. However, in instances where the target species is already present in the estuary system, 
it is important to consider reef placement where there is evidence of shellfish recruitment (e.g., to 
seawalls, adjacent shellfish beds or remnant aquaculture infrastructure). 

TEEB 
category 

Targeted 
ecosystem 
service 

Ecosystem 
processes and 
functions 

Ecological 
benefit/value 

Parameters for 
consideration 

Resources 

Erosion 
prevention 
 

Shoreline 
stabilisation 

Attenuates 
and/or 
dissipates 
wavers, 
sediment 
retention 

Increase submerged 
aquatic vegetation 
(SAV) & adjacent 
saltmarsh habitat, 
decrease effects of 
sea level rise and 
storm surges 

Shoreline exposure 
(fetch + wind direction + 
wind speed), current 
velocity, vessel traffic, 
existing erosion 
hotspots, substrate type, 
sedimentation risk 
presence of seawalls 

(Chowdhury et 
al., 2019, de 
Paiva et al., 
2018, La Peyre 
et al., 2015, 
Dunlop, 2016, La 
Peyre et al., 
2014, 
Theuerkauf et 
al., 2017) 
 

Habitat for 
species 
 

Boosting 
biodiversity & 
recreational 
fishing 

Provides 
suitable 
reproductive 
habitat and 
nursery 
grounds, 
sheltered living 
space 

Increase 
biodiversity and 
productivity, and 
recreational fishing 
use 

Proximity to complex 
habitats, distance from 
mouth of estuary, 
overlap of existing 
habitat of oyster 
predators (e.g. Bream),  

(Gilby et al., 
2020) 

Wastewater 
treatment 
 

Water 
filtration 

Provides 
nutrient and 
pollution 
uptake 

Decrease 
suspended solids, 
turbidity, 
phytoplankton 
biomass and 
microbial 
production. 
Increase 
dendrification and 
SAV 

Current velocity, areas 
of high turbidity/TSS, 
areas with high levels of 
chlorophyll-a/algal 
bloom hotspots, water 
flow rate/velocity 

(Theuerkauf et 
al., 2019) 
 

http://teebweb.org/


 

 

A major target outcome of restoration is to develop healthy, resilient and self-sustaining reefs, as well as 
optimize reef placement with respect to estuarine hydrology and existing spawning adult shellfish 
populations. These considerations are essential to continued larval flow to the newly built reef during the 
initial rapid growth phase. Similarly, the genetic diversity that comes with distinct metapopulations within 
an estuary is important to building a resilient reef habitat with the capacity to respond to and cope with 
multiple stressors in the system. 

Incorporation of larval dispersal considerations into a restoration suitability model can take a variety of 
forms. In simple, semi-quantitative approaches, known patterns of prevailing currents paired with 
knowledge of potential larval source populations can be considered within models to link larval source 
areas with the associated areas of larval dispersal and potential recruitment (Figure 40; e.g., Hixon et al. 
(2022)), In more sophisticated approaches, hydrodynamic models can be linked with particle dispersal 
models to directly estimate and quantify patterns of larval dispersal and recruitment (Figure 40; e.g., 
Theuerkauf et al. (2021); Puckett et al. (2018)). 

  

Applications for ecosystem and seascape- scale suitability modelling  
Another emerging restoration application is seascape-scale restoration suitability modelling. Restoration 
itself is moving to a much more holistic approach, with less projects tackling single species or habitat 
restoration, and more targeting ecosystem-wide restoration. For instance, the US’s “living shoreline” 
projects attempt to build back multiple habitat types supporting numerous organisms. Thinking about 
multispecies and multihabitat restoration is an exciting and emerging new concept to consider in the space 
of restoration suitability modelling. As a whole, these approaches could take the form of integrating 
multiple restoration suitability models for individual species to identify areas of overlap where multispecies 
or multihabitat restoration is feasible. 

Indigenous collaboration: Cultural and environmental considerations. 
Indigenous knowledge systems and resource use have been in play for thousands of generations 
throughout Australia and are particularly relevant for the coastal ecosystems. Traditional Owner (TO) 
groups have seen climate change in action as sea levels have fluctuated throughout time. Indigenous land 
and sea management incorporates these knowledge systems with deep cultural responsibility for the 
health of country. It is with this understanding that TNC outlines a process to encourage early engagement 

Figure 40. Larval dispersal patterns of surgeonfish among coral reefs in Kīholo Bay, Hawaii; source Hixon et al. (2022) (left) and 
map depicting larval dispersal patterns in the Albemarle-Pamlico Estuarine System, North Carolina, US; source Theuerkauf et 
al. (2021) (right). 
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and project development with traditional owners with possibilities for co-design and realisation of TO’s 
aspirations for country and people. Indigenous Knowledge (IK) including Traditional Ecological Knowledge 
(TEK) is an area of considerable omission from many geospatial models used for decision support and is an 
area where more expansive and thoughtful approaches to integrate this knowledge and understanding of 
natural systems is needed. Incorporation of cultural mapping in the modelling process is a way of 
collaborating with TOs from project outset with opportunities to incorporate TEK and cultural knowledge 
into co-design considerations (Poole 2003). This method reflects the principles of participatory research 
and is being increasingly used in Northern Australia with traditional owners and knowledge holders 
(Sithole, 2012). 

IK and TEK is distinct from western science, citizen science and local knowledge, in that they include not 
only direct observations and interactions with plants, animals, and ecosystems, but also a broad spectrum 
of cultural and spiritual knowledges and values underpinning human–environment relationships often 
across long time scales (Molnár and Berkes, 2018). It is important to attend to the common challenges and 
opportunity of IK and TEK integration by following guidance for conducting research in a culturally 
sensitive, productive and equitable manner (Molnár and Berkes, 2018; Jessen et al., 2022). 

Whilst a recent synthesis indicates that integration of TEK can present methodological challenges, there is 
emerging consensus that TEK reaches its full potential when involved and incorporated at all levels of the 
research and modelling process (Bélisle et al., 2018). Importantly, integration of TEK should come from an 
‘inclusive’ approach or perspective wherein all stakeholders are contributing and working towards a 
common objective and mission, rather than an ‘extractive’ approach i.e., holders of TEK are included solely 
for the information that they can provide. Within the restoration guide, we identify multiple opportunities 
where early and frequent stakeholder engagement can play a pivotal role in the development of useful 
restoration suitability models. However, innovation and creative approaches are still needed towards full, 
appropriate integration of TEK and IK into restoration suitability models, as well as the restoration planning 
process more generally. 

6.2 Role of new technology 
Remote sensing 
New technology is rapidly emerging and being applied in restoration, particularly in remote sensing and 
machine learning applications. Many of these new technologies may help meet critical data limitations 
when conducting landscape-scale analyses similar to restoration suitability modelling. Given the rapid 
anthropogenic changes to our estuaries, catchments and marine environments, the biological, chemical 
and physical complexity has increased enormously. High resolution and spectral imagery from either 
satellite and/or drone-based capture is greatly contributing to the efficient collection of data across large 
geographic areas. Arial imagery and LiDAR- derived products have been used to track changes in ecosystem 
extent and condition, monitor movement of invasive species and predict habitat migration under sea-level 
rise scenarios. Examples of high-resolution data sources include: Google Earth, Earth Explorer, Sentinel 
Hub, Planet, DigitalGlobe (now the Maxar Open Data Program) and NearMap. 

Satellite remote-sensed data has also been used to estimate environmental variables that relate to water 
quality. However, the remote sensing approach has been largely limited to their optical properties based 
on visible, near-infrared and infrared signals (i.e., turbidity, chlorophyll-a and sea surface temperature) 
(Miller and McKee, 2004; Harvey, Kratzer and Philipson, 2015; Kilpatrick et al., 2015). These data and 
information are useful to model spatial trends within surface level or shallow embayments. Depth-related 
subsurface measurements of water quality parameters are generally of more use as an indicator for 
suitable conditions for shellfish and other bottom-dwelling sessile organisms. Stratification of estuaries is 
not uncommon, and this can sometimes create distinct hypoxic layers as well as thermo- or haloclines in 
the water column leading to long-lasting habitat effects, which can potentially be detrimental to shellfish 
health. In situ water quality is one of the most critical data gaps, as there is no complete, state-wide 
estuarine water quality monitoring program across many states in Australia, the collection of such data is 
often left to the discretion of the local council. Water quality as we know is a critical parameter when 



 

 

assessing the site suitability for shellfish reefs, as the bivalves are largely sessile creatures, they do not have 
the ability to move towards more suitable conditions should the need arise. Emerging technology such as 
Raman spectroscopy to measure subsurface temperature and salinity (Artlett and Pask, 2017), amongst 
development of hydrodynamic models and other remote-sensing applications may assist in further 
addressing some of these limitations. 

Environmental DNA analysis 
Using environmental DNA (eDNA) assays to determine the larval presence of a target shellfish species has 
been shown to give accurate results. Previously it was difficult to detect the presence of larvae in project 
areas. eDNA analyses are even capable of detecting the difference between closely related species of 
shellfish larvae. The use of eDNA could be utilised for the management of restoration projects to help 
detect potential drivers of the disappearance of the target species like parasites or invasive species. In the 
past detecting certain detrimental invasive species in shellfish required lethal methods (Marshall and 
Stepien, 2019).  

6.3 Role of other tools 
In addition to restoration suitability models, there are a wide range of other decision support tools that can 
provide valuable information to support the success of restoration efforts. NGOs, government agencies, 
academic institutions, and the private sector develop and manage these tools, many of which are web-
based and publicly available.  

The Nature Conservancy develops and manages a range of science-based conservation decision support 
tools, such as the Coastal Resilience and Mapping Ocean Wealth platforms, as well as the Oyster Calculator. 
Coastal Resilience is an online mapping platform to provide planners, government officials, and 
communities with information to develop risk reduction, restoration and resilience strategies. Mapping 
Ocean Wealth is a data viewer to support a shared understanding of the value of marine and coastal 
ecosystems to people—including a range of global maps, regionally-specific studies, reference data, and a 
number of ‘apps’ that provide key data analytics. The Oyster Calculator is an ‘app’ within the Mapping 
Ocean Wealth platform that uses two key ecosystem services — water filtration and fish production — to 
provide insight into how ecosystem services can be used to set restoration objectives, in order to answer a 
critical question of "How much shellfish restoration is enough?" 

Government agencies, such as the U.S. National Oceanic and Atmospheric Administration utilize tools to 
support broad goals of national spatial planning, such as OceanReports, or regional industry planning, such 
as the Gulf AquaMapper. OceanReports is a web-based, report-centric tool that provides coastal and ocean 
planners in the United States with a high-level of automated spatial analysis for a custom-drawn area of 
interest—providing insights on a broad range of environmental and/or space-use interactions. The Gulf 
AquaMapper and National AquaMapper provides industry-specific information to support spatial planning 
and siting of new aquaculture operations amongst a landscape of opportunity and constraints-based 
parameters.  

Collectively, these tools can place a specific restoration project within the broader context of other ocean-
based industries or conservation priorities (e.g., OceanReports), or provide deeper insights into potential 
outcomes of specific restoration activities (e.g., Oyster Calculator). 

 

 

 

 

https://coastalresilience.org/
https://oceanwealth.org/
https://oceanwealth.org/
https://oceanwealth.org/tools/oyster-calculator/
https://www.gisforscience.com/chapter3/v2/#learn-more
https://coastalscience.noaa.gov/products/gulf-aquamapper/
https://coastalscience.noaa.gov/products/gulf-aquamapper/
https://www.arcgis.com/home/item.html?id=4f12cbde0c22488196dda69d495116cc
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Appendix 

Appendix A: Sample Data Parameters 

Parameter Criteria (more suitable = 4, unsuitable = 0)  Rationale 

Bathymetry  4 - 10 m = 4; 0-3 m = 0; >10m= 1; 3 - 4 m = 1 logistically difficult to construct below 
10m; risk of disturbance in less than 3m 
depth 

Salinity Average N/A Not included in model because all areas 
fell within known ecological tolerance 

Temperature 
Maximum 

N/A Not included in model because all areas 
fell within known ecological tolerance 

Dissolved Oxygen 
Minimum 

N/A Not included in model because all areas 
fell within known ecological tolerance 

Substrate  N/A Not included in model due to suitable, 
soft substrate across study area 

Seagrass avoidance  Areas with no seagrass = 4; areas with 45%+ 
coverage = 0; 15 - 45% coverage = 1, <15% 
coverage= 2 

Limit impact to existing seagrass beds 

Seagrass proximity Areas within 5-500m buffer =4; 5m buffer 
around 45% + coverage = 0; all other areas = 
2 

Connectivity to other structured habitats 
increases diversity, but want to avoid 
building directly on dense seagrass beds 

Rocky reef proximity N/A Not included in model  

Shipping channel 
avoidance -small craft 
channels 

Areas within 20m of nav channel = 0; 20 - 
50m buffer = 2; all other areas = 4 

Reduce threat of collision, need for 
remapping, risk to divers  

Shipping channel 
avoidance- large craft 
channels  

N/A Not included in model due to lack of 
distinction between shipping channels for 
small vs. large crafts 

Recreation/ski/watercr
aft zones avoidance  

Areas within waterski zones = 1; areas within 
a 50m buffer = 2;  all other areas =4;  

Reduce threat of collision, need for 
remapping, risk to divers  

Aquaculture zones 
avoidance 

Aquaculture areas = 0; 0 - 20m buffer around 
areas = 1, 20 - 50m buffer = 2; all other areas 
= 4 

Safe working zone from aquaculture sites 

Commercial fishing 
zones avoidance 

Area A = 1; Area B = 2; all other areas are = 4 Reduces risk of gear damage or reef 
damage 

MPAs N/A Not included in model b/c no MPAs in 
study area 

Culturally sensitive 
areas avoidance 

N/A Not included in model b/c no known areas 
in study area 



 

 

Historical reefs 
proximity  

N/A Not included in model b/c no known areas 
in study area 

Remnant reefs/known 
areas of high density of 
shellfish proximity  

N/A Not included in model b/c no known areas 
in study area 

Distance from shore N/A Not included in model because all areas 
within 2km of shore 

Navigational 
Aids/Moorings/Coastal 
Infrastructure 

All areas within 20m buffer = 0; all areas = 4 Risk of interference with buoys/moorings 
and coastal infrastructure 

Mooring Areas Within a zone is 0, outside is 4 Risk of interference with buoys/moorings 
and coastal infrastructure 

Slope >2° = 0, 20-25° = 1, <20° =4 Difficulty of constructing/maintaining 
oyster reef on steep slopes 
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Appendix B: Strategies for stakeholder engagement and consultation 
Stakeholder engagement and community consultation throughout the 
restoration planning process is critical to the success of the project and an 
important component of the restoration suitability modelling stage and site 
selection. One of the first steps in the planning phase of projects is to 
undertake a stakeholder mapping process to identify all stakeholders that 
need to be engaged.   

Feedback received from these consultations is used to feed into parameter 
selection, determination of parameter criteria and validation of the 
restoration suitability modelling. After retrofitting the model with the 
feedback received, a second round of consultation is recommended, 
especially if the suitability of the proposed restoration areas has changed 
considerably. This would ensure reaching a final agreement of the 
restoration sites that satisfies all parties. 

Within the stakeholder engagement and community consultation stage, there are different key groups 
depending on their role within the project area broadly these are (1) government agencies and 
organisational (professional) stakeholders, (2) community groups and recreational stakeholders, (3) 
Traditional Owners. 

Government agencies and professional stakeholders: 
This group is formed by the relevant agencies that will have a key role in the permitting process of the 
project, and their consultation is mandatory. This group could also include relevant stakeholders that will 
provide insightful information or that their consultation will provide a stronger case for easing the 
permitting process and ultimately the restoration suitability modelling. Examples of key stakeholders are 
fisheries and relevant government agencies, National Parks and Wildlife Services, landowners (Crown 
Lands), local councils, waterways management/catchment authority, maritime services (of particular 
importance in high recreational or commercial boating estuaries such as Ports), industry (aquaculture). It’s 
also worth meeting with government agencies responsible from reviewing permitting applications early on 
in the project and restoration suitability modelling process, to address any concerns and forecast any 
potential challenges ahead of time. 

Government agencies and organisational (professional) stakeholders are a key part of not only the 
restoration suitability modelling stage, as they are often crucial data providers, but to the permitting, 
regulatory and governance process for restoration. Sometimes, some government agencies may also be 
project partners, and this would benefit the consultation process as they may offer assistance on 
identifying and contacting key local agencies and stakeholders. 

Early consultation with government agencies in the data acquisition stage, prior to building the restoration 
suitability model, ensures that the model parameters adhere to guidelines of governing bodies. This data 
acquisition step is often the first contact between practitioners and relevant government departments and 
sets a solid platform for the restoration to move forwards from. 

Once the model is built and the potential restoration areas are selected, an official consultation with the 
local government bodies and professional stakeholders will occur. Several key steps help the consultation 
process run smoothly: 

1. Identify main government bodies in the area and their potential representatives, examples are:  

o Natural Resources Manager of the local Council 

o Government agencies responsible for reviewing the permits 

o Fisheries and/or Primary Industries Manager 

o Landowner Agencies 



 

 

o Maritime Officers 

o Biosecurity managers (in case of seeding or shell deployment may occur) 

o Other relevant government agencies 

o Local industries (aquaculture operations managers, etc) 

2. Official consultation: Official consultation may take place by grouping several agencies and/or 
professional stakeholders into a single meeting depending on their expertise, or meeting each 
of them independently. At the official consultation, several aspects of the project will need to be 
covered assuming no prior knowledge of the restoration project and target ecosystem/species:  

o Introduce the project lead and project team  

o Define target ecosystem and introduce why there is a need to restore (history of decline 
and benefits i.e. ecosystem services) 

o Project outline: Why restore reefs within this geographic area, project goals, reef 
restoration processes, methods, materials and potential involvement opportunities. 

o Site selection process, restoration suitability modelling and potential sites 

o Question and Answer (Q&A) session. 

3. Feedback: Each agency is likely to provide feedback on their area of expertise. Based on the 
feedback received, the information could be integrated back into the restoration suitability 
model and/ or the site selection process.  

4. Agreement: Further consultation will be required to reach a final agreement. It is important to 
integrate every potential concern/question or feedback item raised on the official consultation 
in the project planning and readjust any necessary part of the project accordingly. In further 
consultations, it is important to provide information regarding the updated areas of the project 
based on the feedback received and provide several options to come to a consensus to any 
potential concerns and or questions raised. Often negotiation is key at this step and maintaining 
a good relationship with stakeholder groups is critical, as consultation will likely occur 
throughout the life-cycle of the project. 

 

Community groups 
Community groups and recreational stakeholders often play a central role in the development on the 
project and their feedback is of equal value as professional stakeholder consultation. The importance of 
community groups within a waterway varies geographically, so before any consultation, it is important to 
identify relevant community groups and their role within the community. Among these, local fishing 
groups, conservationist and environmental groups, rowers and kayakers, surfing and swimming clubs, 
diving clubs, could take part on the consultation process. Engaging community groups early on in the 
planning stages is critical to gaining social licence, support, and buy-in this local support is critical and can 
make or break a project, particularly in the regulatory approvals stage. 

1. Undertake initial contact with the local catchment or natural resource management body to gauge 
an understanding about what they may consider to be the expected community response and 
highlight any potential concerns. 

Attempt to mitigate any negative outcomes from subsequent direct engagement with stakeholders, 
by addressing and predicting potential concerns that may arise in discussions. For each community 
group or broad category of community groups (e.g. recreational fishers) its good practice to 
organise workshops or community engagement events that are specifically tailored to the group in 
question It is important to ensure you have answers to expected questions from the community, a 
good practice is to develop a list of frequently asked questions for restoration projects in the 
geographic region of interest. 
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2. Conduct preliminary stakeholder workshops. Consider having a few workshops or community 
engagement events targeted to different user groups (e.g. recreational fishing clubs, or a collection 
of local birdwatchers, and conservationist groups). Adjusting the content presented for each type of 
community group, can help address any niche concerns. Also consider having a mediator present 
who knows the community group, e.g., representative from local council or similar. 

These preliminary workshops should introduce similar items of these mentioned on the 
government agencies and professional stakeholder consultations: 

o Introduce the project lead and project team  

o Define target ecosystem and introduce why there is a need to restore (history of decline 
and benefits i.e. ecosystem services) 

o Project outline: Why restore reefs within this geographic area, project goals, reef 
restoration processes, methods, materials and potential involvement opportunities. 

o Site selection process, restoration suitability modelling and potential sites 

o Q&A session: Q&A session is key, as it is when the group would provide feedback and 
several activities may ensure the final success of the consultation. This can include: 

 Facilitating a first round general Q&A session. During this time, general questions 
and concerns about the project could be raised.  

 Facilitating a map study session by providing printed maps and markers and allow 
the group to provide feedback on their preferred sites for restoration and areas 
to avoid. Facilitating a resolution session through featuring a board or power 
point slide where concerns could be annotated and among the group, try and 
provide solutions/actions to ease/solve these. 

o Wrap up: Outline feedback received from the group, provide your contact details in case 
they want to address some more individually and provide information or next steps 
(integrate feedback and find/provide potential solutions). 

 

3. Amongst team, refine potential sites selected, refine suitability model if required, ITs critical after 
receiving community feedback to be able to demonstrate how this has been incorporated into the 
planning process. 

4. Follow-up stakeholder workshop. This workshop should primarily show that we have incorporated 
community feedback from previous workshop(s) into the restoration planning process and 
addressed any concerns. This workshop should also take the opportunity to further refine potential 
sites suitable for restoration and allow the community to voice any further concerns. It’s important 
to recognise that there may always be dissenting views in the community. Therefore, it’s vital to 
work with local community leaders and project advisors to understand and determine if these views 
are widely shared or if these views only represent a small number of vocal individuals. 

 

Traditional Owners 
It should be clearly stated at the outset that Traditional Owner groups do not sit within the stakeholder 
group setting given their unique status and long connection to place. This can be recognised by law (i.e., 
ALRA or Native Title Act), or may be recognised either as a treaty or similar (i.e., Noongar Native Title 
Settlement Act) or as long-standing custodianship without any of these legal recognition (i.e., Larrakia 
people of Darwin). This does not diminish the sense of connection to country and the cultural responsibility 
of managing country for one’s group and ancestors. As outlined in some of the aforementioned legal 
documents, consultation with indigenous people for a project should involve “free, prior and informed 
consent” at a minimum. 



 

 

Consultation and engagement with TOs should obviously be considered as close to the project start time as 
possible, if not before the project has commenced. Early engagement and commitment to full consultation 
with TO groups, which should involve remunerative engagement of people, is an important part of 
developing an ongoing relationship. One point of difference between TO groups and regulatory agencies is 
the pathway to approach the relevant organisations due to structural and cultural differences. In many 
cases there will be an appropriate Aboriginal Land Council and/or Native Title Representative Body listed 
for a particular region. In addition to this there may be listed Aboriginal Corporations (as listed under Office 
of Registered Indigenous Corporations (ORIC)) who may also represent groups of local people. 

It is commonly reported amongst western science organisations that practitioners do not know how or 
who to approach in order to discuss a project idea with the TO of an area and in many cases, nothing 
transpires due to an inability to start the relationship. Often in these situations, once projects are 
underway, project staff have little time to get the relationship started and these aspirations remain 
unfulfilled. To alleviate some of these challenges, many government and university research organisations 
are employing Cultural Engagement Officers (i.e., AIMS and CSIRO) who are aboriginal people with science 
and research training and can help facilitate researcher, TO project collaboration and outcomes. It is 
important to consider the time, logistics and costs of proper engagement processes which should be 
outlined and itemised in any proposed finding application. 
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